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All pressure equipment with an internal pressure greater than 0.5 bar (g) and a size larger than 25mm or 1" (inch) falls under the Pressure Equipment Directive (PED). 
• The Specifications Section of this manual contains instructions related to the PED directive. 
• Products described in this manual are in compliance with EN directive 2014/34/EU. 
• All Brooks Instrument Flowmeters fall under fluid group 1. 
• Products larger than 25mm or 1" (inch) are in compliance with PED category I, II or III. 
• Products of 25mm or 1" (inch) or smaller are Sound Engineering Practice (SEP). 

European Pressure Equipment Directive (PED) 

The Brooks Instrument (electric/electronic) equipment bearing the CE mark has been successfully tested to the regulations of the Electro Magnetic 
Compatibility (EMC directive 2014/30/EU). 
Special attention however is required when selecting the signal cable to be used with CE marked equipment. 
Quality of the signal cable, cable glands and connectors: 
Brooks Instrument supplies high quality cable(s) which meets the specifications for CE certification. 
If you provide your own signal cable you should use a cable which is overall completely screened with a 100% shield. 
“D” or “Circular” type connectors used should be shielded with a metal shield. If applicable, metal cable glands must be used providing cable screen clamping. 
The cable screen should be connected to the metal shell or gland and shielded at both ends over 360 Degrees. 
The shield should be terminated to an earth ground. 
Card Edge Connectors are standard non-metallic. The cables used must be screened with 100% shield to comply with CE certification. 
The shield should be terminated to an earth ground. 
For pin configuration : Please refer to the enclosed Instruction Manual. 

European Electromagnet Compatibility (EMC) 
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Chapter 1 Introduction 
1.1 Description 

The Brooks’ Expert Support Tool is a Windows®-based application that 
provides expanded monitoring & control of the Brooks’ digital thermal 
mass flow controller/meter, flow controller/meter, pressure controller and 
remote pressure transducer (RT), and pressure-based flow controller 
modes for servicing tasks that include setup, configuration, calibration, 
tuning, control, monitoring, and troubleshooting. For device 
troubleshooting information, refer also to the device’s Installation and 
Operations Manual. 
Use of some features requires a Pro software license which is 
obtainable on a subscription basis. Contact Brooks Instrument to obtain 
a license. See Table 2-4 through Table 2-9 for a list of which features 
require a license. 
Note that this user manual covers only the use of BEST with SLA Rev B 
(“Enhanced”), PC1xx, VDM300, GF40, GF1xx, and GP200 devices. 
BEST also supports SLA Rev A (“Legacy”) and Quantim B devices. 
Those products are covered by a separate BEST user manual for those 
products. 

 
Figure 1-1 BEST Main Screen 

Note that the Brooks Expert Support Tool is meant to be used as a 
startup and troubleshooting tool. It is not intended to be permanently 
connected to the device in your system/application. 
See Table 1-1 for all product models supported by BEST. 
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Table 1-1 Device Model Families Supported in BEST 

Model Code Device Type Description 
SLA58** MFC/MFM/PC Mass Flow Controller, Meter, Pressure 

Controller 
SLA78** MFC/MFM/PC Mass Flow Controller, Meter, Pressure 

Controller 
SLA79** MFC/MFM/PC Mass Flow Controller, Meter, Pressure 

Controller 
SLAMF** MFC/MFM Mass Flow Controller, Meter 
PC115 PC Pressure Controller (Upstream or 

Downstream)1 
PC125 PC Pressure Controller (Downstream) with Flow 

Meter1 
VDM300 MFC DI Water Vapor Delivery Module 
GF40 MFC Thermal Mass Flow Controller 
GF80 MFC Thermal Mass Flow Controller 
GF1xx MFC Thermal Mass Flow Controller2 
GF095 MFC Thermal Mass Flow Controller 
GP200 MFC Pressure-based Flow Controller 
Quantim B MFC Coriolis Flow Controller3 
Quantim C MFC Coriolis Flow Controller4 
SLA Rev A MFC Thermal Mass Flow Controller3 
1. DeviceNet Only 
2. Includes GF095, GF100, GF101, GF120, GF121, GF125, GF126, GF135 
3. See alternative user manual for Quantim B and SLA Rev A 
4. Quantim C requires a newer version of FloCom/FloComPlus/FloCom database. See Table 2-11.  

 

1.2 How to Use This Manual 
It is recommended that you read the device Installation & Operations 
Manual (IOM) prior to reading this manual. Read this manual in its 
entirety before installing or using the Brooks Expert Support Tool. 
Note that the illustrations of screens from BEST are illustrative – the 
exact appearance on your computer screen may vary slightly. Also, if 
software versions are shown on the illustrations, your versions may vary 
slightly. 
Note: For device troubleshooting information, refer to the device’s 
Installation and Operations Manual. 

1.3 Integrated Help 
This user manual (which is searchable) can be accessed directly from 
the software, on the About->User Manual menu item. see Section 5.2. 
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Chapter 2 Installation 
This section describes the system requirements, how to install the BEST 
software onto a personal computer (PC), and how to connect the PC to 
the device. 

2.1 Hardware Requirements 
The hardware requirements are specific to each Brooks device.  
Brooks devices will have one of two diagnostic port connections: 2.5 mm 
jack plug or Micro USB. See Table 2-1. 
Table 2-1 Connector Types 

Device Model 2.5mm Jack Plug Micro USB 

SLA X  

PC1x5 X  

VDM300  X 

GF40   X  

GF1xx   X  

GF095  X 

GP200  X 

Quantim C X  

 
The device is connected from its diagnostics port to a computer via the 
computer’s serial port or USB port. Various cable/adapter combinations 
are available to connect a device to the PC.  
The following adapters and cables are typically examples required to 
connect a device with the 2.5mm jack plug diagnostic port to the 
computers standard serial port: 

• RS232 to RS485 converter. 
• Service port cable with 2.5-mm jack plug and 9-pin sub-D 

connector. 
 

 

 
Figure 2-1 RS232 to RS485 Converter, cable  
(2.5-mm jack plug to 9-pin sub-D conn.) 
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The following adapters and cables connect a device with the 2.5mm 
jack plug diagnostic port to the computer’s standard USB port: 

• USB to RS485 converter. 
• Service port cable with 2.5-mm jack plug and 9-pin sub-D 

connector. 
 

 
Figure 2-2 USB to RS485 Converter 

 
Other adapter combinations may be possible. 
This equipment may be purchased either along with the Brooks Expert 
Support Tool software or separately from Brooks Instrument. Contact 
the factory or your local representative for details. 

 
Table 2-2 Available Brooks Instrument Cable Kit Options 

Part Number Description 
778Z010ZZZ Basic Cable Kit 
A331710003 Cable Assembly 2.5mm 
214F027AAA USB-RS485 converter with DB-9 

female 
778Z012ZZZ RS485 Analog/Profibus® Cable 

Kit w/Power Supply 24 Vdc 
641Z117AAA Power Supply 24 Vdc with DB-15 

female 
778Z013ZZZ EtherCAT® Cable Kit w/Power 

Supply 24 Vdc 
124Z170AAA Cable, Power, EtherCAT to DB-15 

male 
778Z014ZZZ DeviceNetTM Cable Kit w/Power 

Supply 24 Vdc 
124Z171AAA Cable, Power, DeviceNet to DB-

15 male 
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The following tools and cables connect a device’s Micro USB diagnostic 
port the PC’s standard USB port: 

• Standard USB to Micro USB cable 

 
Figure 2-3 Standard USB to Micro USB cable 

*NOTE: No “license dongle” is required, but a software license is 
required for Pro features of BEST. 
For device label printing, a label printer is required. All printer models 
are supported – the user is responsible for installing the printer 
manufacturer’s drivers as needed. 

2.2 System Requirements 
This section describes system and software requirements to use the 
Brooks Expert Support Tool application on a personal computer (PC). 
The Brooks Expert Support Tool application can be installed on a 
Windows PC with the following requirements: 

 
Table 2-3 System Requirements 

Component Minimum Requirements 
Operating System Microsoft Windows 11 

Microsoft Windows 10 
Microsoft Windows 8 – BEST has not been 
formally tested with Windows 8 

COM Port One dedicated serial port or  
USB port with USB to serial adapter, and 
RS232/RS485 adapter   

Software License Required for Pro Features (Calibration) 
See Table 2-4 to Table 2-9 for specifics 
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Table 2-4 Pro Features Requiring a License for SLA Rev B Products 

Feature Standard 
Version (No 
License) 

Pro Version 
(License) 

Connection ✓ ✓ 
Terminal Commands X ✓ 
View Device Info ✓ ✓ 
Dump File ✓ ✓ 
Wake Up State ✓ ✓ 
Protocol Settings ✓ ✓ 
Get Firmware Revision ✓ ✓ 
Update Firmware X ✓ 
Model Code Editing* X ✓ 
Restrictor Selection X ✓ 
Orifice Selection X ✓ 
Meter Simulate MFC X ✓ 
Reboot/Power Cycle ✓ ✓ 
Control Source/Valve Control/Set Point ✓ ✓ 
Graph/Basic Status/Meters ✓ ✓ 
Warning Status ✓ ✓ 
Alarm Status ✓ ✓ 
User Totalizer ✓ ✓ 
Data Logging ✓ ✓ 
Sensor Zero ✓ ✓ 
Create Gas Page ✓ ✓ 
Pressure Application Instance ✓ ✓ 
Response Tuning ✓ ✓ 
Sensor Tuning X ✓ 

Flow Calibration (MFC, MFM, RT devices)* X ✓ 
Pressure Calibration (PC devices) X ✓ 
Graph Settings ✓ ✓ 
User Totalizer Settings ✓ ✓ 
Warning Settings ✓ ✓ 
Alarm Settings ✓ ✓ 
Top Label Printing ✓ ✓ 

Can Label Printing X ✓ 

*Some restrictions exist for Biotech devices. 



Brooks® Expert Support Tool 

 

2-5  
 

Table 2-5 Pro Features Requiring a License for PC115/125 Products 
Feature Standard 

Version 
(No 

License) 

Pro 
Version 
(License) 

Connection ✓ ✓ 
Terminal Commands X ✓ 
Device Info ✓ ✓ 
Dump File X ✓ 
Wake Up State ✓ ✓ 
Protocol Settings  ✓ ✓ 
Get Firmware Revision ✓ ✓ 
Update Firmware X ✓ 
Reboot/Power Cycle ✓ ✓ 
Control Source/Valve Control/Set Point ✓ ✓ 
Graph/Basic Status/Meters ✓ ✓ 
Warning Status ✓ ✓ 
Alarm Status ✓ ✓ 
User Totalizer ✓ ✓ 
Data Logging ✓ ✓ 
Sensor Zero ✓ ✓ 
Create Gas Page ✓ ✓ 
Tuning ✓ ✓ 
Graph Settings ✓ ✓ 
User Totalizer Settings ✓ ✓ 
Warning Settings ✓ ✓ 
Top Label Printing ✓ ✓ 

Alarm Settings ✓ ✓ 
Top Label Printing ✓ ✓ 
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Table 2-6 Pro Features Requiring a License for VDM300 Products 

Feature Standard Version 
(No License) 

Pro Version 
(License) 

Connection ✓ ✓ 
Terminal Commands ✓ ✓ 
Device Info ✓ ✓ 
Dump File ✓ ✓ 
Wake Up State ✓ ✓ 
Protocol Settings ✓ ✓ 
Get Firmware Revision ✓ ✓ 
Update Firmware ✓ ✓ 
Reboot/Power Cycle ✓ ✓ 
Control Source/Valve Control/Set Point ✓ ✓ 
Graph/Basic Status/Meters ✓ ✓ 
Warning/Alarm Status ✓ ✓ 

Alarm Status ✓ ✓ 
Data Logging ✓ ✓ 
Sensor Zero ✓ ✓ 
Response Tuning ✓ ✓ 
Graph Settings ✓ ✓ 
Warning Settings ✓ ✓ 
Alarm Settings ✓ ✓ 
Calculators ✓ ✓ 
Automated Dry-Down Operation ✓ ✓ 
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Table 2-7 Pro Features Requiring a License for GF40 Products 

Feature Standard 
Version (No 
License) 

Pro Version 
(License) 

Connection ✓ ✓ 
Terminal Commands X ✓ 
Device Info ✓ ✓ 
Dump File ✓ ✓ 
Wake Up State ✓ ✓ 
Protocol Settings (S Protocol devices only) ✓ ✓ 
Get Firmware Revision ✓ ✓ 
Update Firmware X ✓ 
Model Code Editing X ✓ 
Meter Simulate MFC X ✓ 
Reboot/Power Cycle ✓ ✓ 
Control Source/Valve Control/Set Point ✓ ✓ 
Graph/Basic Status/Meters ✓ ✓ 
Alarm/Warning Status (RS485 devices only) ✓ ✓ 
Alarm/Warning Settings (RS485 devices only) ✓ ✓ 

Data Logging ✓ ✓ 
Sensor Zero ✓ ✓ 
Select Active Gas Page ✓ ✓ 
Create Gas Page ✓ ✓ 

Tuning ✓ ✓ 
Analog I/O Calibration ✓ ✓ 

Flow Calibration X ✓ 
Device WARP X ✓ 

Graph Settings ✓ ✓ 
Top Label Printing ✓ ✓ 

Can Label Printing X ✓ 
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Table 2-8 Pro Features Requiring a License for GP200 Products 

Feature Standard 
Version (No 
License) 

Pro Version 
(License) 

Connection ✓ ✓ 
Terminal Commands ✓ ✓ 
Device Info ✓ ✓ 
Dump File ✓ ✓ 
Wake Up State ✓ ✓ 
Protocol Settings ✓ ✓ 
Get Firmware Revision ✓ ✓ 
Model Code Editing X X 
Update Firmware ✓ ✓ 
Reboot/Power Cycle ✓ ✓ 
Control Source/Valve Control/Setpoint ✓ ✓ 
Graph/Basic Status/Meters ✓ ✓ 
Warning Status ✓ ✓ 
Alarm Status ✓ ✓ 
User Totalizer ✓ ✓ 
Data Logging ✓ ✓ 
Sensor Zero ✓ ✓ 
Create Gas Page ✓ ✓ 
Graph Settings ✓ ✓ 
User Totalizer Settings ✓ ✓ 
Warning Settings ✓ ✓ 
Alarm Settings ✓ ✓ 
Top Label Printing ✓ ✓ 
Flow Calibration X X 
Device WARP ✓ ✓ 
Top Label Printing ✓ ✓ 
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Table 2-9 Pro Features Requiring a License for GF1xx Products 

Feature Standard 
Version (No 
License) 

Pro Version 
(License) 

Connection ✓ ✓ 
Terminal Commands ✓ ✓ 
Device Info ✓ ✓ 
Dump File ✓ ✓ 
Wake Up State ✓ ✓ 
Protocol Settings  ✓ ✓ 
Get Firmware Revision ✓ ✓ 
Update Firmware ✓ ✓ 
Model Code Editing X X 
Meter Simulate MFC ✓ ✓ 
Reboot/Power Cycle ✓ ✓ 
Control Source/Valve Control/Set Point ✓ ✓ 
Graph/Basic Status/Meters ✓ ✓ 
Alarm/Warning Status ✓ ✓ 
Alarm Status ✓ ✓ 
Data Logging ✓ ✓ 
Sensor Zero ✓ ✓ 
Select Active Gas Page ✓ ✓ 
Create Gas Page ✓ ✓ 

Tuning ✓ ✓ 
Flow Calibration X X 
Flow Validation ✓ ✓ 
Device WARP ✓ ✓ 

Graph Settings ✓ ✓ 
Alarm/Warning Settings ✓ ✓ 
Top Label Printing ✓ ✓ 

Can Label Printing X X 
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Table 2-10 Pro Features Requiring a License for Quantim C Products 

Feature for QMC Standard Version 
(No License) 

Pro Version 
(License) 

Connection ✓ ✓ 
Terminal Commands X ✓ 
Device Info ✓ ✓ 
Dump File ✓ ✓ 
Wake Up State (power-up attribute values) ✓ ✓ 
Protocol Settings ✓ ✓ 
Get Firmware Revision ✓ ✓ 
Update Firmware X ✓ 
Reboot/Power Cycle ✓ ✓ 
Control Source/Valve Control/Setpoint ✓ ✓ 
Graph/Basic Status/Meters ✓ ✓ 
Warning Status ✓ ✓ 
Alarm Status ✓ ✓ 
User Totalizer ✓ ✓ 
Data Logging ✓ ✓ 
Sensor Zero ✓ ✓ 
Firmware Updating X X 
Graph Settings ✓ ✓ 
User Totalizer Settings ✓ ✓ 
Warning Settings ✓ ✓ 
Alarm Settings ✓ ✓ 
Label Printing ✓ ✓ 
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Table 2-11 Pro Features Requiring a License for GF80 Products 

Feature Standard 
Version (No 
License) 

Pro Version 
(License) 

Connection ✓ ✓ 
Terminal Commands X ✓ 
Device Info ✓ ✓ 
Dump File ✓ ✓ 
Wake Up State ✓ ✓ 
Protocol Settings (S Protocol devices only) ✓ ✓ 
Get Firmware Revision ✓ ✓ 
Update Firmware X ✓ 
Model Code Editing X ✓1 
Meter Simulate MFC X ✓ 
Reboot/Power Cycle ✓ ✓ 
Control Source/Valve Control/Set Point ✓ ✓ 
Graph/Basic Status Monitoring ✓ ✓ 
Alarm/Warning Status (RS485, Profibus devices 
only) ✓ ✓1 

Alarm/Warning Settings (RS485, Profibus devices 
only) ✓ ✓1 

Data Logging ✓ ✓ 
Sensor Zero ✓ ✓ 
Select Active Gas Page ✓ ✓ 
Create Gas Page ✓ ✓ 

Response Tuning ✓ ✓ 
Analog I/O Calibration (RS485. Profibus devices 
only) ✓ ✓ 

Flow Calibration X X 
Device WARP X ✓ 

Graph Settings ✓ ✓ 
Top Label Printing ✓ ✓ 

 
1. MFC726 only. 

 
 
2.3 Installing the Brooks Expert Support Tool Application 

This section describes how to install the Brooks Expert Support Tool 
application onto a personal computer (PC). 
Uninstallation of existing versions of BEST prior to installation is not 
required, but recommended. See Section 2.5 for more details about 
uninstallation. 
To install the Brooks Expert Support Tool application, download the 
BEST installer file from the Products/Software section of the Brooks 
Instrument website 
(https://www.brooksinstrument.com/en/products/accessories-
software/product-software). Once the installation file is downloaded, 
decompress if necessary. 
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Before installing, open and read the Readme file for last-minute updates 
and helpful notes that may not be included in this user manual. 
Before starting the BEST installer, it is recommended to disconnect or 
power down any mass flow devices connected to the computer’s serial 
ports or USB ports. 
Run the setup.exe file - it is recommended to run this file as an 
administrator. Right click on the file and a pop-up menu appears. (See 
Figure 2-4). Click “Run as administrator.” 

 
Figure 2-4 Running Setup.exe as an Admin 

Next, follow the installation instructions provided by the software. It is 
strongly recommended to install BEST and its components in the default 
folders provided by the installer. 
The installer will install BEST and its required software components, 
including versions of FloCom, FloComPlus and the FlocCom databases. 
For users who require a specific version of the FloCom database 
component, during the installation, the user will be presented with a 
software component selection menu (See Figure 2-5). Uncheck the item 
FloCom Databases to preserve the currently installed version and not 
install the version from the installer.  
*NOTE: BEST requires certain versions of FloCom, FloComPlus, and  
FloCom database be installed for maximum functionality. If you do not 
install the database version from the installer you must ensure that the 
desired version of FloCom database is installed separately from the 
BEST installer. 

Table 2-12 FloCom Recommended Versions Installed with BEST 5.14 

Program Required Version 
FloCom 6.20 
FloComPlus 2.04 
FloCom Database 20240405 
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Figure 2-5 Installer Software Component Menu  
(Your versions may vary) 

Virtual COM Port Driver: To use BEST with the VDM300 device it is 
necessary to install the virtual COM port (serial port/USB) driver. This 
driver is normally installed via the BEST installer. Make sure that the 
Virtual COM Port Driver check box is checked (see Figure 2-5).  
See also the ReadMe file for more information about the Virtual COM 
port driver. 
USB to Serial Port Driver: To use BEST with the USB to RS485 
adapter, this driver is needed. 
During installation, if it is installing a software component that already 
exists, the installer may present you with the options of Modify, Repair, 
or Remove, or similar: typically, choose repair. If it presents you with the 
options Complete or Custom, choose Complete. 
The installer will optionally create an item in the Brooks Instrument 
program group and a shortcut icon on the Windows desktop. 
Upon completion of installation, a software license must also be installed 
for access to Pro features of BEST. Contact Brooks Instrument to obtain 
a license. License installation instructions are covered in Section  5.1.2. 

2.4 License Installation 
To obtain a license, the user must contact Brooks Instrument to obtain a 
yearly license subscription. The user will receive a license key (a 
number), then enter it in the License Key text block (see Figure 2-6). 
*NOTE: After receiving your license key, store it in a secure location 
(backed up and secure from unauthorized use) for later retrieval. 
Normally, the license installation process requires an Internet 
connection. A license can be installed without an Internet connection – 
contact Brooks Instrument for details.  
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To install a license, click on the menu Help->License->Install License. 
The window in Figure 2-6 will appear.  

 
Figure 2-6 License Installation Window 

Copy and paste your license key text into the License Key text box. 
Then click Install. The software will attempt to use an Internet 
connection to contact Brooks Instrument to verify the license. Then the 
license will be installed on the local computer. You will receive a 
message when it is finished. To view the installed license, click the 
menu item Help->License->Info. See also Section 5.1.1. 

 
Figure 2-7 License Information Window 

2.5 Uninstalling the Brooks Expert Support Tool Application 
To uninstall BEST, go to the Windows Control Panel -> Programs and 
Features. Look for any items entitled “Brooks Expert Support Tool”. 
Right click the item and select Uninstall. Follow the onscreen 
instructions. 

Repeat for any items with the title “Brooks Expert Support Tool”. 
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*NOTE: The uninstallation does not uninstall any of the auxiliary 
components such as FloCom or FloCom databases, installed with 
BEST. These do not necessarily need to be uninstalled, but to uninstall, 
repeat the above paragraph for the items “FloCom”, “FcPlus”, etc. 

2.6 Connection Procedure 
To connect Brooks devices utilizing the 2.5mm jack plug diagnostics 
port to the computer: 

1. Connect the RS232 side of the RS232 to RS485 converter to a 
serial port on your computer. Ensure the “RS485” side is 
connected away from the computer. 

2. Alternatively, you may user a USB to RS485 in place of the 
RS232 to RS485 converter. Connect the converter to a USB port 
on your computer. Ensure the “RS485” side is connected away 
from the computer. 

3. Insert the 2.5-mm jack plug into the device’s diagnostics 
port (labeled “DIAG” on the device, as shown in Figure 
2-9). 

4. Connect the desired power cable to the device and to the 
power source. Reference the device manual. 

5. Verify that the device is powered on and the MOD LED is 
solid green or flashing red. 

 
Figure 2-8 RS232 to RS485 Connection 

For Brooks devices utilizing a Micro USB port, connect a standard USB 
to Micro USB cable between the computer’s USB port and the device’s 
Micro USB diagnostic port. 
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Figure 2-9 Typical Diagnostics Port Connection (SLA Rev B Model shown) 

 
Figure 2-10 Typical Diagnostics Port Connection (Pc1xx Model shown) 

 
Figure 2-11 Micro USB Diagnostic Port (VDM300 model shown) 
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2.7 Disconnecting the PC from the Device 
When you are done using the Brooks Expert Support Tool, you should 
disconnect the computer from the device. 
To disconnect the computer from the device’s service port: 

1. Detach from the device using the software Connection Window. 
2. Exit from the Brooks Expert Support Tool software, optionally. 
3. Disconnect the cable between the computer and device. 
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Chapter 3 Basic Operations 
This section gives a general introduction to the basic operation of BEST, 
including starting BEST, the main screen, establishing communications 
with a device, viewing the main graph window, detaching from a device, 
and the menus. 

3.1 Main Screen 
 

To start BEST, select BEST from your Start menu, or double-click its 
application shortcut. The main window displays, with no devices 
connected. 

 
Figure 3-1 Main Screen with Device Connection Window 

The Title Bar shows the name and current version of the software. The 
title bar can also be used to select, move, and maximize the window, 
according to Windows conventions. 
The Menu Bar is where most functionality of BEST is accessed. BEST 
windows are opened from the menu bar. Menu items are typically 
accessed from left to right and top to bottom. 
The BEST desktop is where all opened BEST windows exist. This is 
similar to the Windows desktop, except that this desktop contains only 
BEST windows. See also Chapter 6. 
The Status Bar shows useful instructions and messages about the 
current status of the software and its processes. 
 
If the user is using dual monitors, the user may gain additional space for 
windows by dragging the side edge of main screen across to the 
additional monitor. 
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When the software first starts, it shows the device connection window in 
the center of the screen. To use most features of BEST, you must first 
“attach” (or establish communication with) a device using the device 
connection window. see Section 10.1 for more details about the 
Connection Window. 

3.2 Attaching to a Device 
The first thing to do is to establish communications with (or “attach" to) a 
device. 
When BEST software starts, no devices are attached. Devices are 
attached via the device connection window. For convenience, the 
software opens the device connection window for you upon startup. 
First, in the Device Connection/COM Port drop-down list (See Figure 
3-2), select the COM Port you are using to connect to your device.  
Next, select the desired Baud rate from the Device Connection->Baud 
rate drop-down list. Most users will choose Optimize, which will 
automatically select the fastest baud rate that successfully 
communicates with the device. if you have trouble attaching to a device, 
you can try a lower baud rate to troubleshoot. Your selected port and 
baud rate selections will be retained by BEST for your convenience. 
Click the Next > 1 Device button to find the connected MAC address. 
After a few moments, if a device is located, its MAC ID (or “address”) is 
listed in the Mac ID drop-down list. 
Once a device’s MAC ID is located, click on the Attach button. After a 
few moments, if it is attached, a row appears in the connected devices 
box, as shown in Figure 3-2. 

 
Figure 3-2 Device Connection Window, Device Attached 

Once the device is attached, close the Device Connection window. 
For some device types, a window will then pop up asking if you want to 
place the device in the executing state. 
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Figure 3-3 Executing Mode Window 

If you need to control the device’s setpoint or valve with BEST, click 
Yes. 

Once the device is attached, close the Device Connection window. 
Likewise, when detaching from a device, it may ask you if you want to 
place the device in the idle state or SafeState. 

 
Figure 3-4 Idle Mode Window 

See also Section 10.1 for more details about device connections. 

3.3 Main Graph 
 

Once a device is attached, you can run the main graph to monitor the 
behavior of the device. Click on the green button in the upper left corner 
of the Devices Connected block. The main graph window will open, then 
Click Start. 
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Figure 3-5 Graph Window 

see Section 8.4 for more details about the graph window. 

3.4 Closing the Session with the Device and Exiting BEST 
 

To close the communication session with a device and exit the software, 
open the File menu and choose Exit, or click the window’s close button 
(the X in the upper right corner). Exiting the software automatically 
closes all communications with the device. 
Alternatively, the user may close the communications with (or “detach” 
from) the device, by opening the Device Comm->Connection menu. 
Then click Detach. The user may attach to another device, if desired. 

3.5 Brooks Expert Support Tool Conventions 
 

The Brooks Expert Support Tool was designed to remain consistent with 
regard to how the user interacts with the application across all functions 
and features. It is also generally consistent with Windows user interface 
conventions. 
The following text field conventions apply throughout the software: 

• Text fields with a gray background display a read-only 
value (such as the Current Position (%) in Figure 3-6). 

• Text fields with a white background are editable 
(such as Set Point Position (%) in Figure 3-6). 

• Usually, editable text fields update the software or device 
either when the user clicks the Enter button, when the 
focus moves to another field by using the Tab key or 
mouse, or when a separate apply button is clicked (see 
each section in the manual for specific instructions). 
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• If a text box contains “NaN” or “n. def.” it means “Not a 
Number”, not defined, or invalid calculation result. 

Many windows also require numeric input from the user. This type of 
window is also called a “form”. For numeric input, forms often feature 
numeric up/down controls. See Figure 3-6 for an example of a numeric 
up/down control (circled). 

 
Figure 3-6 Example Numeric Up/Down Control 
Up/down controls help prevent invalid numeric data entry. Click the up 
arrow to increment the numeric value, or the down arrow to decrement. 
Up/down controls also have maximum and minimum values. You may 
also type in a number directly, but it won’t allow non-numeric entry. Also, 
in some cases, it won’t accept the thousands separator character (for 
example, “,” in English culture). In most forms, you may also click enter 
to accept the entered value, or move the focus off the control to another 
control on the form. 
Data Entry and International Locales: While BEST doesn’t translate 
all words from the English language, BEST supports various number 
and date formats for data entry and display, according to the user’s 
computer settings for that region (see Control Panel->Region and 
Language on your computer). BEST uses the user’s Windows settings 
for region and locale for most numeric data, except where noted in this 
manual. For example, when entering a decimal number in English a 
user might type 1.234 into a text box, but for German culture, one would 
enter 1,234 because in that culture the comma is the decimal separator. 
*NOTE: In some BEST windows you must always enter English 
formatted numbers (because that is what the device expects). For 
example, in the terminal window, you must use English decimal number 
formats because the commands that a device accepts require English. 
In those types of windows, a statement will be present on the form as a 
reminder. 
For most windows in BEST, for data entry, you must use the format of 
your region, except where noted. Likewise, most windows will display 
numbers in the format of your region, except where noted. 
The sample illustrations in this manual are shown using the English 
region formatting. 
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3.6 Menu Bar 
 

The Menu Bar (see Figure 3-1) is where most of the functionality of 
BEST is accessed. Most BEST windows are opened from the menu bar, 
and then those windows will exist on the BEST Desktop. Menu items are 
typically accessed from left to right and top to bottom. 

Note that this manual shows all menu items. Certain menus may not 
appear if the features of those menus are not supported by the currently 
selected device. 

Subsequent chapters of this manual describe each of the menus in 
detail. 
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Chapter 4 File Menu 
The File Menu Item contains a place to exit the program. See Figure 4-1. 
(You may also exit the program via the “X” in the upper right of the title bar, 
according to Windows convention). 

 
Figure 4-1 File->Exit Menu 
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Chapter 5 Help Menu Item 
The Help Menu Item is where information about the BEST software can 
be accessed, including the current version of BEST, licensing options, 
and user help. A device connection is not required to access these menu 
items. 

 
Figure 5-1 Help Menu 

5.1 About Window 
 

The About-> About Menu Item is where information about the current 
version of BEST and its software components can be viewed. 
Information provided includes the current version of BEST and it 
software components. (The current version of BEST is also always 
visible in the main window’s title bar.) 

 
Figure 5-2 About Window  
(Your versions may vary) 
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5-1 

5.1.1 License Info Window 
The License Info Menu Item is where information about installed licenses 
for the current version of BEST can be viewed (but not updated). The user 
may also set options about when to be reminded of license expiration. 

 
Figure 5-3 License Information Window  
(Your data may vary) 

5.1.2 Install License Window 
The Install License Menu Item is where licenses may be installed (and 
uninstalled). The user must contact Brooks Instrument to obtain an 
annual license subscription, if desired. The user will receive a license 
key (a number), then enter it in the License Key text block. 
*NOTE: After receiving your license key, store it in a safe location 
(backed up and secure from unauthorized use) for later retrieval. 
Normally, the license installation process requires an Internet 
connection. A license can be installed without an Internet connection – 
contact Brooks Instrument for details. 
 

 
Figure 5-4 License Install Window 
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5.1.3 EULA Window 
The EULA is where the user may view the End User License Agreement 
(EULA). 
 

5.2 User Manual Menu 
 

This BEST user manual (which is searchable) can be accessible directly 
from the software under the Help->User Manual menu. A PDF file reader 
(such as Adobe Reader or Microsoft Edge) must be installed on the 
computer to read this file. 
 

5.3 ReadMe Menu 
 

The user may view last-minute updates (not included in this manual) as 
well as technical and useful troubleshooting information from this menu. 
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Chapter 6 Window Menu 
The Window Menu Item is where BEST windows can be accessed and 
controlled. 
BEST windows exist on the BEST desktop (see Figure 3-1). This is 
similar to the Windows desktop, except that the BEST desktop contains 
only BEST windows. 
BEST windows are sized and closed in a similar way as in the Windows 
operating system. Most BEST windows can be sized, minimized, 
maximized, and restored. Some BEST windows have minimum and/or 
maximum sizes. Multiple windows may be opened with some 
exceptions. Some windows, such as calibration windows, when they are 
open, do not allow access to other windows until they are first closed. 
(These are called “modal” windows). A modal window cannot be 
minimized or maximized, but may be resized by dragging the sizing 
handle in the lower right corner of the window (if the windows is not 
maximized). 
Note also that the title bar of each BEST window shows the serial 
number of the device associated with that window. 

 
Figure 6-1 Window Menu 

If any windows are open in the BEST desktop, they will be listed in the 
Window menu under the Arrange item (See Figure 6-1). Clicking on one 
of those items will activate that window. 
The Close All Window menu item closes all windows (for all devices). 
The Cascade Window menu item, arranges all open windows in a 
“cascade” arrangement from the upper left corner of the windows. See 
Figure 6-2. 



Brooks® Expert Support Tool 

 

6-2  
 

 
Figure 6-2 Cascaded Window Layout 

 
Figure 6-3 Tiled Window Layout 

Tile will arrange all open windows in a “tiled” arrangement. See Figure 
6-3. 
Minimize All minimizes all windows to an icon representation. See 
Figure 6-4. 
NOTE: If a modal window is minimized, it will disappear into an icon at 
the bottom of the screen. To restore it, click on the icon. 
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Figure 6-4 Minimized Windows 
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Chapter 7 Settings 
The Settings Menu Item is where BEST software options can be 
changed to the user’s preferences. These are software options, not 
device options. Most of the features in this menu do not require a device 
connection. Menu items shown depends on device type. 

 
Figure 7-1 Settings Menu 

7.1 Graph Options 
The Graph Options is where the user can select options and 
preferences for the operation of the main graph window. Here the user 
can select preferences such as the data units, scaling, number of 
decimal places, and graph legend options. See Figure 7-2 for the Graph 
Options window. 

Device 

 
Figure 7-2 Graph Options Window 

For each graph parameter, the user can choose which parameters to 
show on the graph, legend, and meters panel (see Section 8.4 for more 
information on the meters panel of the main graph window). 
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The user can also choose to allow the software to determine which 
device parameters to show automatically by choosing to select Auto 
Show Default Parameters, in which case the software will show only 
the parameters relevant for the device type (for example, an MFC 
device will not show pressure or pressure setpoint). If Auto Show 
Default Parameters is checked, the individual parameters’ Show on 
Graph check boxes will be disabled – if it is unchecked they will be 
enabled. For most usages, leave Auto Show Default Parameters 
checked. 

*NOTE: If you need a higher data sample rate on the main graph, such 
as with response tuning, uncheck the Auto Show Default Parameters 
check box and select only the parameters you need to view. Unchecking 
the Valve Position parameter can yield significant increases in sample 
rate. 

For each parameter, the user can choose “device units” in which case 
the units stored in the device are automatically chosen for display. 

The graph Y axis scaling for both the left side Y axis and the right side Y 
axis can adjusted by the user. The left side axis is for flow, flow setpoint, 
pressure, and pressure setpoint. The right side axis is for valve position, 
valve current, temperature, and density.  

The Num Dec Places block sets the number of decimal places 
displayed for numeric data across the software. 

Valve current is for VDM300 devices only. 
*NOTE: For some parameters, changing graph settings while the graph 
is running may require the graph to be closed and re-opened for the 
changes to take effect. 

7.2 Reset All User Options 
Reset All User Options is where the user can reset all BEST software 
user settings to their factory default settings. Use with caution.  
 

7.3 Data Logging Options 
The Data Logging Options Menu Item is where the user can set 
preferences as to whether data from the main graph window is to be 
saved to file as it monitors. Check the check box Save Data To Log to save 
data to file. Files can be saved in either text or csv format. The file name will 
be created automatically. The folder is listed in the Data Log File Path text 
box. The user can also conveniently open saved files from the path by 
clicking a single button, the Open File button. See Figure 7-3 for the Data 
logging options window. 
The data logging status (on or off) is shown at the bottom of the main 
graph window. 

The user may also have some control over the sample rate (of both the 
graphical display and the recorded data). Under the units drop-down, 
select Maximum to obtain the maximum sample rate on your system. 
Otherwise, select SamplesPerSecond or SecondsPerSample, then set the 
Target rate. The target rate is not a guaranteed rate, nor is the rate 
guaranteed to be precise. 
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Figure 7-3 Data Logging Options 

7.4 User Totalizer Options 
For devices that support a totalizer, the User Totalizer Options Menu 
Item is where the user can set preferences for the user totalizer for 
devices that support a totalizer. (NOTE: the user totalizer is different than 
the device’s hardware totalizer. See Section 8.3 for details on the 
hardware and user totalizers). The user can set preferences as to how 
often to update the user totalizer window and can reset the user totalizer. 
See Figure 7-4. The user totalizer units are always the same as the 
device’s setting for totalizer units. 
A device must be attached to see and use this window. 

 
Figure 7-4 User Totalizer Options 
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7.4.1 User Totalizer Options 
 

For SLA devices with EthernetIP digital I/O option, a different 
totalizer window is used. 

 
 

 
Figure 7-5 EthernetIP Totalizer 

 
For the fmTotalizer, the user may set the total value to a specific 
value. Change the value in “New Flow Total” then click Set 
Value”. The user may not change the fmFlowHours. 
The user may also change the mode for the fmCustFlowTotalizer. 
To stop the totalizer, change the New Mode to Stop, then click 
Set Mode. To reset the totalizer, change the New Mode to Reset, 
then click Set Mode. To restart the totalizer, change the New 
Mode to Run, then click Set Mode.
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Chapter 8 Monitoring Menu 
The Monitoring menu gives the user the ability to monitor various 
aspects of the device. Each of the windows accessible through the 
Monitoring menu, when opened, shows a live status of various 
parameters of the device. This includes alarms, warnings, flow, 
pressure, control, and other status parameters. 

 
Figure 8-1 Monitoring Menu  
(not all devices support all menus) 

Except for the graph window (Section 8.4), and VDM300 DryDown 
Reports (section 8.9), these windows are monitoring as long as they 
are open. These windows update typically at about once per second. 
These windows are read-only windows and can access and display 
these parameters whether the device is in internal (digital) or external 
(analog) control mode. 

Most Monitoring menu windows can be resized by using the mouse to 
grab an edge or corner of the window and dragging. 

8.1 Warning Status 
The Warning Status Window shows detailed warning states for 
supported devices interfaces/protocols. For some device types, the 
warning status is integrated with the alarm status window. The exact 
warnings shown may vary depending on the device type. The warning 
window for a flow controller is shown in Figure 8-2. 
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Figure 8-2 Warning Status Window 
(Actual alarms may vary depending on device type) 

For VDM300 devices, the VDM Warning Status Window shows detailed 
warning states for that device type in Figure 8-3. 

 
Figure 8-3 VDM Warning Status Window 
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8.2 Alarm Status 
The Alarm Status window shows detailed alarm states for supported 
devices interfaces/protocols. The exact alarms/warnings shown may 
vary depending on the protocol type and device type. For SLA 
EthernetIP, GF40, and GP200 devices, the Alarm window also shows 
warnings. The alarm window for an SLA Rev B flow controller with 
RS485 interface is shown below in Figure 8-4. The alarm status window 
can be resized by dragging a corner or edge of the window. 

 
Figure 8-4 Alarm Status Window (RS485) 
(Actual alarms may vary depending upon device type) 
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Figure 8-5 Alarm Status Window (FieldBus) 
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Figure 8-6 VDM Alarm Status Window 

 

 
Figure 8-7 VDM Ethercat Alarm Status Window 
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Figure 8-8 GF40 Alarm Status 
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Figure 8-9 EthernetIP Alarm Status Window, Status Tab 
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Figure 8-10 EthernetIP Alarm Status Window, Errors Tab 
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Figure 8-11 EthernetIP Alarm Status Window, Alarms Tab 
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Figure 8-12 EthernetIP Alarm Status Window, Warnings Tab 
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Figure 8-13 GP200 Alarm Status Window 

8.3 User Totalizer Window 
(The following section applies only to devices that support a totalizer 
and does not apply to SLA EthernetIP devices. For SLA EthernetIP 
devices, see Section 7.4.1). 

The User Totalizer allows a user to track to total flow of a device over 
time form a user reference point in time. The User Totalizer is only 
supported if the device supports a hardware flow totalizer.  

*NOTE: The User Totalizer is different from the hardware totalizer. The 
hardware totalizer is a totalizer that exists in the device firmware. The 
hardware totalizer cannot be reset, as it is for maintenance purposes. 
The user totalizer, however, is based on the hardware totalizer. 

The User Totalizer may be reset by clicking the Reset button in the 
window. The window’s update rate and flow units displayed may be set 
by the user (see Section 7.4). The window shows the total elapsed time 
since the last reset. 

User totalizer options are set via the User Totalizer options  
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(see Section 7.4). 

 
Figure 8-14 User Totalizer Window 

8.4 Graph Window 
The Main Graph window shows device measurements such as flow, 
flow set point, pressure, pressure set point, temperature, and valve 
position, over time. It also features some commonly used control 
functions. 

 
Figure 8-15 Main Graph Window 

 (actual appearance may vary depending on device type) 

When the main Graph window is opened it does not start monitoring 
automatically. To start monitoring, click the Start button. Click Stop to 
stop monitoring. Click Start to re-start, or Resume to resume monitoring. 
There are a number of options of the graph that the user can select. 
They can be selected in the Tools->Options->Graph menu (see Section 
7.1). 
The parameters that are graphed on the window, the units used for the 
parameters, X scale, Y scale, and legend are all user options. 
The left side Y axis is for flow, flow setpoint, pressure, and pressure 
setpoint. The right side Y axis is for valve position, valve current, 
temperature, and density.  
The Meters Panel shows important device measurements. (The name 
“meters” was chosen because a flow meter measures flow, a 
temperature meter measures temperature, etc.). The exact parameters 
that are shown may change depending on the user graph settings and 
the type of device (see Section 7.1). The Meters Panel is also where 
the user selects the control source and set point. 
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The Control Source can be either Digital (BEST Software) or Analog 
(External) for control of the set point. If the control source is set to digital, 
the user controls the set point via BEST software via the diagnostics port 
(see Set Point Control section below). If analog is selected, the software 
no longer controls the set point, (but can still monitor the set points) – the 
set point is control by an external controller physically connected to the 
device on its normal control port (and not via the Diagnostics port). 
Selecting analog disables BEST software’s set point up/down control. 
Selecting digital control re- enables it. Changing the Control Source from 
analog to digital will cause the software to change the device’s set point 
to 0 for safety. 
The Set Point Control allows the user to set the device’s set point via 
BEST software (if Control Source is set to digital). The units for the set 
point are displayed next to the numeric up/down control. These units are 
the same as set by the graph options for set point (flow or pressure set 
point depending on the type of device - see Section 7.1). If the user 
changes the units options under the graph options menu, the units here 
will be updated to match and the numeric value will be updated to the 
equivalent units. 
The Basic Status Panel shows some basic status parameters. The 
displayed parameters are: 

• Monitoring: Whether the main graph is currently Running or 
Stopped. 

• Full-scale: Displays the full-scale flow or pressure range of the 
active device (value and units). 

Communication: Will show “Active” or the last error message, if any. 
Alarm: Will show “Alarm”, “Warning” or “Normal”. Alarm will show if any 
alarm is active. To see which alarm is occurring, open the Alarm Status 
window (see Section 8.2). If there is no alarm, but a warning is 
occurring, this will show “Warning”. To see which warning is occurring, 
open the Warning Status window (see Section 8.1). 
Valve State: Will show the valve control state: Manual, Normal, Open, or 
Closed. Manual means manual control, normal means set point control 
of the valve. Open means valve override open. Closed means valve is 
forced closed. 
Control Source: Analog or Digital. 
Flow Totalizer: The value of the hardware totalizer (See also Section 8.3). 
Data Logging: On Or Off. 
Oper. Mode: The current operating mode of the device - Executing 
mode, or Idle/Safestate mode. (Show only on devise that support 
executing mode). 
EIP Control: Shows “Yes” if the device is currently controller by the 
EthernetIP connection (shown only for SLA rev B EthernetIP devices) 
 
There is a user Text Annotation block that can be used for labeling 
purposes. The text can be edited, moved, and resized. To edit the text 
block, click on the text block, type in the new text, then click off the 
block. To move the text block, click on the text block and a frame will 
appear - then drag the box to the desired location. To resize the text 
block, click on 
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the text block and a frame will appear – then drag one of the handles 
(sides or corners). To clear the text, select the text and edit it to an 
empty text string. If the text is hidden, click Find Annot. Double click the 
text box to edit the text. 
Screen Capture: The graph can be saved to a graphics file by clicking 
Capture. Supported graphics file format are jpg, bmp, gif, png, and tiff. 
Print Screen: The graph can also be printed. Click Print. 
Cursor: The user can display a cursor on the graph. A cursor is cross-
hair that can pin point a location on the graph. To activate a cursor, click 
anywhere on the graph with the mouse. A crosshair appears and in the 
lower right corner of the graph, a box appears with the X and Y location 
of the cursor Figure 8-16. To move the cursor, click on another location 
in the graph and the location of the cursor is updated in the box. To 
remove the cursor, right click on the graph. A context menu appears – 
click Clear Cursor (See Figure 8-17). 

 
Figure 8-16 Main Graph Window with Cursor 

 
Figure 8-17 Main Graph Window with Context Menu 
Zoom: The user can zoom in on a portion of the graph. To zoom in, click 
anywhere on the graph with the mouse, then drag diagonally to form a 
rectangle, then release the mouse. The graph shows a zoomed area of 
the graph and scroll bars appear (see Figure 8-18). To remove the zoom 
effect, right click on the graph. A context menu appears – click Reset 
Graph Zoom (see Figure 8-18). 
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Figure 8-18 Graph Window Zoomed 

NOTE: For some parameters, changing graph settings while the graph 
is running may require the graph to be closed and re-opened for the 
changes to take effect. 

8.5 VDM Status Window 
The VDM Status Window allows the user to view and change selected 
status parameters of a VDM device. When the window first opens, it is 
sampling data at a sample rate of a little slower than 1 sample per 
second. The user may stop, restart or execute a single sample. The 
user may also change the mux mode by selecting a mode from the New 
Mode drop-down and clicking Change. 
If enabled for the current device, the user may also change the operating 
mode of the device by clicking one of the operating mode buttons. 

 
Figure 8-19 VDM Status Window 
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8.6 VDM Heater Diagnostics 
The VDM Heater Diagnostics Menu allows the user to view and record 
the data of VDM device’s heater and heater PWM data over time. The 
sample rate is 1 sample per second. The user may also print or capture 
the screen to graphics file. This menu item applies only to VDM300 
devices. 

 
Figure 8-20 VDM Heater Window 

8.7 Data Streaming 
The Data Streaming Menu allows the user to record data from the 
device (any device that supports FloCom) over time, at a faster and 
more controlled rate than the main graph. The user can select which 
attributes to record, the sample rate, length of time to record, and file to 
save to. The file format is *.csv. Sample rate typically can be up to 500 
Hz, up to eight attributes at a time, depending on selected options. The 
attributes available to select from depends on the type of device. Live 
data on the screen is not available during this operation. No changes or 
other communications with the device can occur via the diagnostics port 
while recording is ongoing. 
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Figure 8-21 Streaming Window 

 
8.8 VDM300 Dry-Down 

The VDM300 Dry-Down Menu allows the user to perform an 
automated dry-down operation of the VDM300. The dry-down 
operation is typically performed with the device in the user’s 
system, or a similar setup. A typical block diagram is shown in 
window of Figure 8-22.  
 
The dry-down process consists of applying pressurized nitrogen 
to the device and cycling the exhaust valve on and off between 
pressurize and depressurize. The nitrogen is applied to the 
device’s outlet port, applying the flow in reverse direction. The 
device heaters are turned on during this operation. 
 
The dry-down process is a long-running automated operation (up 
to 8 hours) and, unlike the manual in-house process, the user 
would typically start the operation and run it unattended (without 
stopping for user prompts to switch manual external valves). 
 
It is recommended that the user consult the factory for additional 
guidance for this operation. 
 
The cycle times and other parameters may be adjusted to the 
user’s preferences. Click the Settings button on the VDM300 Dry-
Down Window (see Figure 8-22 and Figure 8-23). 
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Figure 8-22 VDM300 Dry-Down Window 

 
Figure 8-23 VDM300 Dry-Down Settings Window 

 
To start the test, click Start on the VDM300 Dry-Down Window 
(see Figure 8-22). The software will prompt the user to set up 
some external valves. Then the automated test will start. If there 
is water in the tank, it will be drained. Then the cycling will take 
place unattended. At the end of cycling, the user will be prompted 
to close external valves as necessary.  
 
The user may create a report of the data for documentation 
purposes. Click on Report on the VDM300 Dry-Down Window, or 
click on the menu Monitoring->VDM300 Dry-Down Reports from 
the BEST Main window. See Section 8.9. 
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8.9 VDM300 Dry-Down Reports 
The VDM300 Dry-Down Reports Menu allows the user to view, print, or save a report 
to log the results of a VDM300 Dry-Down operation. In order to be able to see this 
menu item, the software must be connected to a VDM300 device, or no device. 

 

 
Figure 8-24 VDM300 Dry-Down Report Window 
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Chapter 9 Tools Menu 
The Tools Menu Item features some convenient utility tools (for 
reference only). Most of the features in this menu do not require a 
device connection. 

 
Figure 9-1 Tools Menu 

9.1 Pressure Units Calculator 
 

The Pressure Units Calculator Menu Item opens a convenient utility 
that can convert a pressure value from one unit to another. 

 
Figure 9-2 Pressure Units Calculator 

 

9.2 Flow Units Calculator 
 

The Flow Units Calculator Menu Item opens a convenient utility that 
can convert a flow value from one unit to another. The user can optionally 
factor into the conversion the reference temperature, and pressure.  
Conversions involving mass-based units require a gas symbol in both 
drop-down controls.  
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Figure 9-3 : Flow Units Calculator 

9.3 Temperature Units Calculator 
 

The Temperature Units Calculator Menu Item opens a convenient 
utility which can convert a temperature value from one unit to another. 

 
Figure 9-4 Temperature Units Calculator 
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9.4 Density Units Calculator 
 

The Density Units Calculator Menu Item opens a convenient utility 
that can convert a density value from one unit to another. 
Lookup Gas Density will calculate and show the density of the gas 
based on the reference temperature and pressure using the FloCom gas 
database. 

 
Figure 9-5 Density Units Calculator 
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Chapter 10 Device Comm Menu 
The Device Comm Menu Item is where BEST software performs 
communication tasks with a device. The Connection menu item 
establishes communication with a device. The Terminal menu item 
provides low-level communication (sending commands) with a device. 

 
Figure 10-1 Device Comm Menu 

10.1 Device Connection Window 

 
Figure 10-2 Device Connection Window, with no devices attached 

Most features of BEST software require a connection to a device. If you 
attempt to access a feature that requires a device connection and you 
are not connected to a device, you will see a message box like the 
following: 

 

 
Figure 10-3 No Device Connected 
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When BEST software starts, no devices are attached. Devices are 
attached via the device connection window. For convenience, the 
software opens the device connection window for you upon startup. 
You can close the connection window if you wish. If it is closed, you may 
re-open the window via the Device Comm->Connection menu or the 
Connection button in the devices panel (see Figure 3-2). 
BEST supports one or more devices connected simultaneously to their 
diagnostics ports. The use of the connection window is slightly different 
when using a single device compared to multiple devices. 
First, in the Device Connection/Port drop-down list (see Figure 10-2), 
select the COM Port you are using to connect to each device as you 
connect to them one at a time.  
Next, select the desired Baud rate from the Device Connection/Baud 
rate drop-down list. Most users will choose optimize, which will 
automatically select the fastest baud rate that successfully 
communicates with the device. if you have trouble attaching to a device, 
you can try a lower baud rate to troubleshoot. Your selected port and 
baud rate selections will be retained by BEST for your convenience. 
Attaching a single device: 
In case there is only a single device connected, Click the Next > 1 
Device button to find the connected MAC address. After a few 
moments, if a device is located, its MAC ID (or “address”) is listed in the 
Mac ID drop-down list. 
Once a device’s MAC address is located, make sure it is highlighted in 
the Mac ID drop-down list, then click on the Attach button. After a few 
moments, if it is attached, a row appears in the connected devices box, 
as shown in Figure 10-4. 
 

 
Figure 10-4 Connection Window, Single Device Attached 
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Attaching Multiple Devices Simultaneously: 
BEST supports connecting to multiple devices simultaneously. There 
are two methods of doing this: 

1.) Connecting multiple devices via a single COM port.  
2.) Connecting multiple devices via multiple COM ports. 

Single COM Port: 
The diagnostics port of the device supports RS485 communication, which 
is a multi-drop communication type. This means that it’s possible to 
connect multiple devices simultaneously to a single RS485 
communication cable (“daisy chain”). This requires a custom splitter 
cable between a single COM port on the computer and multiple devices. 
(This type of cable is not supplied by Brooks Instrument). Each device 
on a single COM port must have a unique MAC ID address.  
*NOTE: You may not attach both FloCom and non-FloCom devices on 
the same COM port (FloCom devices are SLA Rev B, PC1xx, VDM300, 
GF40, and GF1xx devices. Non-FloCom devices are SLA Rev A, and 
Quantim devices. See also the equivalent BEST manual for Rev A and 
Quantim devices). 
Multiple COM Ports: 
You may also connect devices to multiple COM ports. Each device on a 
single COM port must have a unique MAC ID address on that COM port. 
Using the Software to Attach: 
If you have connected multiple devices to a COM Port, you use the Next 
Click the Next>>All Devices button to find the MAC addresses of all 
devices connected on the selected COM port. 
If the application has found one or more devices on the selected COM 
port, their MAC addresses will be listed in the Mac ID drop-down box. 
Choose the MAC address that you want to connect to from the drop-
down box and click the Attach button for each device you wish to 
attach. (You must attach one at a time). 
The attached devices will be shown in the Connected Devices as shown 
in Figure 10-5. They will also be shown as buttons in the devices panel 
(see Figure 3-2). 
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Figure 10-5 Device Connection Window, Multiple Devices Connected 

Selecting the active device: 
While multiple devices may be attached simultaneously, only one at a 
time is considered the active device. If a single device is connected, it is 
considered the active device. If multiple devices are attached, the active 
device is selected by clicking on its row in the Connected Devices box. 
In Figure 10-5, the device at address 43 is selected as the active device. 
An attached device may also be selected by clicking the button in the 
device panel or clicking the title bar of its associated main graph 
window. When a device is selected, the corresponding button is 
highlighted in green. 
Device Type Codes: 
In the Connected Devices box, under the Dev Type field, the possible 
values are: 

MFC Mass Flow Controller  
MFM Mass Flow Meter 
PC Pressure Controller 
RT Remote Transducer Device 

For purposes of BEST, a VDM300 is considered of type MFC. 
Detaching a Device: To detach a device, make sure that device is 
selected as the active device (by the blue highlight bar), then click the 
Detach button. The device will be removed from the Connected Devices 
list and from the devices panel. This will also close any windows open 
for that device. 
*NOTE: clicking the Detach button detaches the device highlighted in 
blue in the Connected Device list, NOT the device select in the Mac ID 
drop-down box. 
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*NOTE: If you change physical connections to the device or computer 
while the software is running, you may need to exit the software and 
restart it for it to recognize the new connection. 
You may close the Device Connection window with the Close button or 
clicking the “X” in the upper right of the Device Connection window’s title 
bar. 
When you exit the BEST program, all devices are detached 
automatically. 

10.1.1 Connecting to an Unconfigured Device 
BEST can be used to attach to and set up devices (and “blank” boards) 
that have not yet been configured, or have an invalid/unsupported model 
code attribute. If you try to attach to such a device, and BEST does not 
recognize the device’s model code, it will display the Fix Model Code 
window (see Figure 10-6).  

 
Figure 10-6 Fix Model Code Window 

The Fix Model Code window gives the user an opportunity to fix or set 
up the model code. The user may fix the model code in one of two ways, 
as explained below.  

The Device Configuration Code text box shows the current model code 
of the device. The user must select the Desired Device Type (“SLA” = 
SLA Rev B). Then they may use either method below. 

1. Manually type in the model code, if the user knows the correctly 
formatted model code, then validate the code.  

2. Set the model code to a default value, then use the model code 
window to set up the individual fields of the model code. This is 
the preferred method. 
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To use method 1:  

1. Select the Desired Device Type. 

2. Manually type in the model code.  

3. Click Validate. If the validation is bad, check the model code, re-
type, and try again.  

4. Click Change.  

5. The status bar will inform you if the change was successfully 
applied. 

6. Close the Fix Model Code Window. 

To use method 2:  

1. Select the Desired Device Type. 

2. Click Default. The default model code for the selected device 
type will be shown in the Device Configuration Code text box. 

3. Click Change.  

4. The status bar will inform you if the change was successfully 
applied. 

5. Close the Fix Model Code window. 

6. Open the Model Code window (under the Device Config->Model 
Code menu) (see Section 11.5) and set the fields to match your 
device’s hardware. 

After setting the model code correctly, the user should continue setting 
up other attributes as necessary. 

10.2 Terminal Window 
 

The Terminal provides low level communication access with a device. A 
connection to a device is required for this feature. This feature is for 
advanced users. For most device types, a software license is required to 
use this feature. 
*NOTE: All numeric or date information entered into this window must be 
in English culture format. Likewise, any numeric or data information 
displayed in this window are in English culture format. 
 
The terminal window also features a Continuous button to continuously 
measure (once per second) a device attribute. This is convenient for 
troubleshooting. 
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Figure 10-7 Terminal Window 

 
10.3 Script File Window 

 
Figure 10-8 Script File Window 

 

The Script File window allows the user to load and execute a file 
containing a batch of multiple commands. These commands are the 
same type of commands as executed one-at-a-time in the Terminal 
window. The user selects a file by clicking on “Select File”. The user 
may optionally open the file to view it by clicking “Open File”. To execute 
the file, click “Send Command”. The results are then shown in the Result 
text box. 
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A sample script file is shown below in Figure 10-9. Each line of the script 
file may be a command line, a comment line, or a blank line. 

 

Figure 10-9 Sample Script File
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Chapter 11 Device Config Menu 
The Device Config Menu provides functionality to help a user configure a device with 
settings such as model code, control mode, alarm settings, and protocol settings. 
Access to individual settings is device- and license-specific. Functions that are not 
supported for a particular device will not be visible. 

   
Figure 11-1 Device Config Menu  
(not all device types support all menus). 
(Config Parameters menu is for SLA Rev A and Quantim B devices:  
see the separate user manual for details). 

  
A device connection is required to use most of the config functions. 
Also, for most menu functions, if device control source is set to external (analog) 
control, the software will first ask if the user wants to set control to digital/ BEST 
control (required for most config functions). 

 
Figure 11-2 BEST Control Message 
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11.1 Firmware 
 

The Firmware menu allows a user to load firmware or a gas database into a device 
where supported. 
 

 
Figure 11-3 Firmware Menu 

 
11.1.1 Update Firmware 

The Update Firmware menu allows a user to load firmware into a device. It also 
allows a user to view the current revision of the firmware in the device.  
The user must obtain the desired firmware file (contact Brooks Instrument). Then 
select the file under the Firmware Update File Path text box. Then select Update. 
After a confirmation pop-up, the software will load the firmware into the device. 
*NOTE: Only one device must be attached on a given COM Port for the firmware 
update. 

  
Figure 11-4 Firmware Update Window 

 
11.1.2 Update Gas Database 

The Update Firmware menu allows a user to load a gas database into a device. It 
also allows a user to view the current revision of the gas database in the device.  
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Currently, only the GP220 device is supported for this operation. 
The user must obtain the desired gas database file (contact Brooks Instrument). Then 
select the file under the Gas Database Update File Path text box. Then select 
Update. After a confirmation pop-up, the software will load the gas database into the 
device. 
*NOTE: Only one device must be attached on a given COM Port for the firmware 
update. 
 

 
Figure 11-5 Gas Database Window 

 
 
 
11.2 Dump Files 

BEST software allows the user to save and reload a (virtually) complete set of device 
settings in a file. Access to this feature may be dependent upon device type and 
software license level. This type of file is called a dump file.  
NOTE: It is strongly recommended that when you first receive a new device, to 
immediately save the settings in a dumpfile as a backup for future reference or 
restoration. 
Dump files are saved in an unencrypted format.  
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Figure 11-6 Dump File Window 

There two formats of dump file: dump and dumpall. Dumpall is a comprehensive set 
of attributes including “live” attributes. A dump file contains only the settable (non-live) 
attributes. BEST can save or reload either type – just select the desired file extension 
type. 
File names are by default coded using the device serial number and the date/time. 
When the Dump File window opens, it shows a date-coded dump file name for the 
current device serial number and selected dumpfile type. To select a different file 
name, edit the file name/path, or select a new file by clicking Select File.  
To save a dump file, first select a file type under the Save File block, then click Save 
File. If a file already exists, saving a file again will not overwrite any existing file. It 
may take a few minutes to complete the save operation.  
An existing dumpfile may be used to reload settings into a device. The file path of the 
last used dumpfile path is displayed in the File Path text box on the form. To change 
the file, click Select File or type in the file path directly. 
*NOTE: Take caution to load only a dumpfile specified for the current device (same 
serial number). Prior to loading a dumpfile, the software will check the serial number of 
the device and compare it to the serial number in the dumpfile. If they don’t match, a 
warning will be displayed. It is recommended that you do NOT ignore this warning. 
To reload a dumpfile, first select a file by clicking the Select File button. Then click 
Load File. A series of warnings will be displayed. A reload may take a minute or two. 
After reloading, the device will be automatically rebooted. Then, the results text box 
will show any attributes from the dump file that were not able to be loaded. It is not 
unusual for a few attributes from the file to fail to load. 
 
 
 
 

11.3 Device Info 
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The Device Info menu item allows a user to view selected information about a 
connected device. This window is read-only, except for the device serial number 
(useful for advanced users when rebuilding to new device). The device serial number 
and sensor serial number are writable only if the user has the Pro license and the 
device supports it. 

 
Figure 11-7 Device Info Window 
 (the data shown may vary depending on device type) 

11.4 Gas Page Configuration 
The Gas Page Configuration menu item allows the user to do a configuration of the 
settings for a device for a single gas “page”. This menu item merely opens the 
Calibration window with the Customer Page tab pre-selected. See Section 13.12 for 
more details. 

 
11.5 Model Code Window 

The model code window allows the user to view and edit the device’s model code. 
The model code (also called the Product Data Code or “PDC”) is stored in a device 
and identifies the type and options of a device. The model code is a formatted string 
of text characters with coded fields representing various device options. 
Viewing the model code can provide key information for the user about a device. The 
model code window can assist the user in decoding and editing the fields. 
Most users will not need to modify the model code, as the model code is typically 
configured by the factory. However, advanced users, such as those who obtain 
unconfigured devices, may need to modify the model code. A license is required to 
modify the model code. BEST does not support model code editing for all devices, 
even with a license. 
When editing the model code, to protect the integrity of the model code text, the 
model code window does not allow the user to directly edit the text of the model code. 
The model code window requires the user to make selections from pre-defined 
choices for each field. 
*NOTE: It is very important to have a correct model code in the device (the model 
code that matches the hardware configuration), especially before beginning a device 
calibration. The model code is complex, so exercise caution when modifying it. 
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Figure 11-8 Model Code Window 

The process for modifying the model code is as follows. 
First, select a parameter to change (you may modify only one parameter/ field at a 
time). See Figure 11-8. This is chosen from the Parameter drop- down box. Notice 
that as you change the selected parameter there, a section of the model code above 
in the Full Code text box is highlighted – this is the corresponding field of the full 
model code. Notice also that the current value text box changes, as well as the 
description. 
Next, select a new value or new value numeric from the New Value drop-down box. 
Notice that as you change the value, you may see a new description of the new 
value. 
When you have selected the new value that you want, click Update. Note that the 
model code field will not be updated in the device unless you click Update. Notice that 
the field value in the Full Code text box is also updated to the new value. 
*NOTE: All numeric or date information entered into this form must be in English 
culture units/formats. Likewise, any numeric or data information displayed in the form 
are in English culture units/formats. 
Special Fields: 
Restrictor Type: For flow devices, the Restrictor Type field is used for restrictor type 
code, but for pressure controllers, this field is used for pressure transducer range 
code. 
Gas Code: The gas code field is for the process gas, not the calibration gas (if the 
calibration gas is different than the process gas - see Section 13.12). This code must 
be an integer number. 
Gas Range: The gas range field is the range for the process gas, not the calibration 
gas (if the calibration gas is different than the process gas - see Section 13.12). 
Gas Units: The gas units field is the units for the process gas, not the calibration gas 
(if the calibration gas is different than the process gas - see Section 13.12). 
Output Enhancements: For Biotech devices (field = S, T, U, or V), this field cannot 
be modified. 
It is also recommended that after changing the model code, to detach the device, 
cycle power and then re-attach, or reboot the unit (see Section 12.1). 
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11.6 Customer Part Number Window 
The Customer Part Number window allows the user to read and set the customer part 
number attribute in the device, if it supports it.  

 
Figure 11-9 Customer Part Number Window 

11.7 Wake Up State 
The Wake Up State window allows the user to configure the state of the device the 
next time it powers up or reboots (“wakes up”), if the device supports it. In this 
window, the user may also set the control source, the diagnostic port Mac ID 
(address), or RT Device Control mode (for RT devices) upon reboot. See Figure 
11-10. 
When the window opens, it shows the current wake-up state. The user may change 
any of these parameters. The user must click Change to apply these changes. The 
control source is for the power-up control state, not the current control state (see 
Section 8.4 to change the current control state). 
For the Diagnostic Port Mac ID, after the user clicks Change, the device will be 
rebooted (after the user confirms), and the device will remain attached, but with the 
new Mac ID number. 
*NOTE: the wake-up state control source (Digital or Analog) is not necessarily the 
current control state – it is the state of the device after a power-up or reboot. 
The RT Device Control Mode block only appears for RT devices. This is the same 
function as the RT Control mode menu (see Section 11.9). 

 
Figure 11-10 Wake Up State Window  
(the RT Device Control Mode block appears only for RT devices) 

11.8 RT Pressure Controller Direction 
The RT Pressure Controller direction window is used to change the direction 
(upstream or downstream) of the pressure mode of an RT device. 
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This change is available only for RT devices (not available for pressure controller 
devices). 

 
Figure 11-11 Pressure Controller Direction Window 

11.9 RT Control Mode 
The RT Control Mode window is used to change the current control mode of an RT 
device between Flow control and Pressure control modes. This window is only 
available for RT devices. 
*NOTE: This change only affects the current state of the device, not the Wake-Up 
state (see Section 11.7 for the Wake-Up State). 
The window (Figure 11-12) also shows a live reading of the remote pressure 
transducer voltage, if the user clicks Start. 
*NOTE: the changes won’t be applied unless the user clicks Change. 

 
Figure 11-12 RT Control Mode Window 

Changing the Control mode will require a device reboot for the change to take effect. 
The software will prompt and guide the user to do a reboot. 
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11.10 Meter Simulate MFC (Meter Calibration) 
The Meter Simulate MFC window is used to allow a meter device to simulate an 
MFC device. This mode is needed for specific calibration situations, such as when 
calibrating a meter device using a temporary external valve directly connected to a 
meter device’s electronics.  

A license is required for the use of this feature. This feature is supported only for SLA, 
SLA Rev A, GF40, and GF1xx devices. 

There are two ways of calibrating an SLA meter device using BEST:  

1. Using the valve output of the meter. Since the meter version of Brooks SLA 
products contains the same electronics circuitry as the controller version, it’s 
possible to connect a standalone valve or a compatible valve from a Brooks SLA 
controller to the valve output of the electronics circuitry. If the Meter Simulate 
MFC window is used, the meter device will act as a controller and can be 
calibrated just like with any MFC controller. After calibration, the device type 
needs to be configured back to MFM. Note that this valve connected to the meter 
needs to be in the flow path during calibration (see also section 13.12 for full 
calibration instructions) 

2. Using an external valve. In case it’s not possible to connect a standalone valve 
or a compatible valve from a Brooks SLA controller to the valve output of the 
electronics circuitry, it’s possible to put an external valve in the flow path and 
regulate flow using this external valve. Note that the device type needs to be 
configured to MFM. During the calibration, the user will be prompted to manually 
adjust the flow indicated in the pop-up window (see Figure 13-29), to a certain 
percentage by using the external valve (see also Section 13.12 for full calibration 
instructions). 

 
Figure 11-13 Meter Simulate MFC Window 

To use this feature on meter device:  
1. Click the menu item Device Config->Meter Simulate MFC. 
2. Select the desired valve type under New Valve Type. 
3. Click MFC. 
4. Perform calibration as with an MFC device. 
5. Click the menu item Device Config->Meter Simulate MFC. 
6. Select None (Sensor Only) under New Valve Type. 
7. Click MFM. 



Brooks® Expert Support Tool 

 

11-10  
 

*NOTE: Changing the device type with this feature will also change the model code 
and other attributes accordingly, so remember to change this back to MFM device 
type when finished. 

11.11 Protocol Settings Window 
The Protocol Settings window allows a user to change protocol settings for the 
device’s main control port. Reference the device’s specific supplemental manual for 
detailed information concerning the device’s communication protocol. 
*NOTE: these settings are not for the diagnostics port communication settings. 
*NOTE: The user must click Apply for settings changes to take effect. 
The exact protocol settings window that appears depends on the type of protocol 
installed on the device. The software automatically detects the protocol type of the 
device. The exact parameters shown depend on the type of device.  
The types of protocol windows are: 

• S-Protocol (RS485) 
• DeviceNet 
• EtherCAT. 

• Field  Bus 

• EthernetIP 

 
Figure 11-14 Protocol Setting (S-Protocol) Window 
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Table 11-1 S-Protocol Configuration Parameters 

Parameter Description 
Date 32-bit integer value that represents the 

date value that is written and read via 
the S-Protocol Communication port. 
The Date value can be utilized by the 
user for any purpose and has no effect 
on the device 

Descriptor A 16-character string that the user can 
use to describe the device. This 
parameter can be written and read via 
the S-Protocol Communication port. 

Device Type Read Only. Will always be 100 for SLA 
Enhanced devices. 

Data Rate Sets the data rate for serial 
communications of the S-Protocol port. 
Must be 9600, 19200, or 38400. 

User Ref. Temp. Reference Temperature (K) for which 
flow is to be reported if the user-
specified Standard Reference 
Conditions. 

Manuf. ID Read Only. Always 10 for Brooks 
Instrument devices. 

Message A 32-character string that the user can 
use for any desired purpose. This 
parameter can be written and read via 
the S-Protocol Communication port. 

Tag Name 8-character string used to identify the 
device on the network to obtain the 
device’s long address. 

Unique ID No. A 32-bit integer in the range of 0 to 
16777216. This value is assigned by 
Brooks and must be unique for all 
devices supporting the RS485 S-
Protocol. 

User Ref. Pressure Reference Pressure (Pa) for which flow 
is to be reported if the user-specified 
Standard Reference Conditions are 
selected. 

Number of Preambles The number of Preamble characters 
that the device will transmit as part of 
every response message on the S-
Protocol communications port. 

Polling Address Short address of the device, must be in 
the range 0 to 15. This address can be 
used to access the long address from 
the device. 

Flow Units Defines the UOM that flow is to be 
reported in on the S-Protocol 
Communications Port. 

Temp. Units Defines the UOM that temperature is to 
be reported in on the S-Protocol 
Communications Port. 

*NOTE: Brooks Instrument provides an S-Protocol manual that describes the 
operation of the S-Protocol supporting devices. Contact the Factory or your local sales 
representative for more information. 
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Figure 11-15 Protocol Settings (DeviceNet) Window 

Table 11-2 DeviceNet Configuration Parameters 
Parameter Description 
Full-scale Represents the value in counts reflecting the full-scale 

of 100%. 
Producer# Sets the assembly instance used for sending data 

from the device to the master during Poll IO 
communication. 

Consumer# Sets the assembly instance used for sending data 
from the master to the device during Poll. 

Poll IO State 
Transition 

Defines the state of the device, Idle or Executing, 
when a Poll I/O connection is established. 

*NOTE: Brooks Instrument provides a DeviceNet manual that describes the operation 
of the DeviceNet supporting devices. Contact the Factory or your local sales 
representative for more information. 
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Figure 11-16 Protocol Settings (EtherCAT) Window 

 
Figure 11-17 Protocol Settings (FieldBus) Window 
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Figure 11-18 Protocol Settings (EthernetIP) Window, General Tab 
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Figure 11-19 Protocol Settings (EthernetIP) Window,Network Tab 

 
11.12 Warnings and Alarms 

The software supports configuration of warnings and/or alarms for most device types. 
The exact alarms and warnings supported depends on the supported device type and 
options. Pressure-related warnings and alarms, for example, will only be supported by 
the PC and RT models. If the RS485 Analog customer interface with the S-Protocol 
supports flash codes, the MOD LED will flash the specified number of times if a 
certain alarm or warning is raised. This feature is not supported by other customer 
interface types. The DeviceNet customer interface also supports warnings in addition 
to alarms. 
For more specific information on alarms, reference the specific device installation & 
operations manual and/or supplemental manuals. 
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Table 11-3 Event Conditions for Which Alarms/Warnings Can Be Set (SLA) 
Event Condition Model Interface Description 
Program memory corrupt MFC, MFM, PC, RT RS485 Analog, 

FieldBus 
Program memory checksum failure. 

RAM test failure MFC, MFM, PC, RT RS485 Analog, 
FieldBus 

Byte-by-byte test of RAM, detects bad 
memory location. 

Non-volatile memory failure MFC, MFM, PC, RT RS485 Analog, 
FieldBus 

Byte-by-byte test of non-volatile memory, 
detects bad memory location. 

Internal power supply failure MFC, MFM, PC, RT RS485 Analog, 
FieldBus 

Any internally generated power supply 
voltage outside operational limits. Internal 
supply voltages must be within their nominal 
limits. 

Temperature Low/High MFC, MFM, PC, RT RS485 Analog This condition occurs when the internal 
temperature is below the low limit or the 
internal temperature is above the high limit. 
Contact Brooks if there is a need to alter 
these low and high temperature limits. 

Temperature Sensor Failure MFC, MFM FieldBus Connection to the temperature sensor has 
been lost 

Device calibration due MFC, MFM, PC, RT RS485 Analog This condition occurs after the specified 
elapsed hours indicating that the device 
needs to be recalibrated. Default the 
corresponding hours limit is set to 8760 
hours, equal to 1 year. The alarm will be 
cleared once either the alarm is disabled or 
the corresponding hours limit is set different 
from 0 in the Alarm Settings screen. 

Device overhaul due MFC, MFM, PC, RT RS485 Analog, 
Profibus, DeviceNet 

This condition occurs after the specified 
elapsed hours with gas flowing greater than 
0.5%. The alarm will be cleared once either 
the alarm is disabled or the corresponding 
hours limit is set different from 0 in the Alarm 
Settings screen. Default this alarm is set to 
elapse in 8760 hours, equal to 1 year. 

Setpoint deviation MFC, MFM, PC, RT RS485 Analog An alarm/warning condition occurs if the 
difference between the set point and flow 
exceeds the specified limit. 

Valve drive low/high MFC, PC, MFC- RT RS485 Analog, 
Profibus, DeviceNet 

This condition occurs when the valve drive is 
below the low limit or above the high limit. 

No flow indication MFC, MFM, RT RS485 Analog This condition occurs if the measurement of 
flow indicates flow less than the specified 
limit value. 

Negative flow indication MFC, MFM FieldBus Flow has been detected in the negative 
direction below the limit. 

Flow Low/High MFC, MFM, RT RS485 Analog, 
Profibus, DeviceNet 

This condition occurs when flow is below the 
low limit or above the high limit. 

Totalizer Overflow MFC, MFM, RT RS485 Analog This condition occurs if the Flow Totalizer 
value exceeds its maximum value. 

Flow Totalizer MFC, MFM FieldBus User alarm flow totalizer has reached zero. 
Time Totalizer MFC, MFM FieldBus User alarm Time totalizer has reached zero. 
Pressure Low/high PC, RT RS485 Analog, 

Profibus, DeviceNet 
This condition occurs when the pressure is 
below the low limit or above the high limit. 

Flow controller error band MFC, RT Profibus, DeviceNet An alarm/warning condition occurs if the 
difference between the set point and flow 
exceeds the specified limit. 

Pressure controller error band PC, RT Profibus, DeviceNet An alarm/warning condition occurs if the 
difference between the set point and 
pressure reading exceeds the specified limit 
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11.13 Warning Settings 
The Warning Settings window allows a user to change warning settings for the 
device. This is similar to alarm settings. Warnings are not supported on all devices. 
For GF40 and SLA Rev B EthernetIP device types, warning settings are accessed via 
the Alarm settings menu. 
The Low Limit and High Limit are in terms of the units specified under the units 
column for each row. 
*NOTE: The user must click Apply for settings changes to take effect. 

 
Figure 11-20 Warning Settings Window, Ethercat 

 
Figure 11-21 Warning Settings Window, VDM 

 
 
11.14 Alarm Settings 

The Alarm Settings window allows a user to change alarm settings for the device. 
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*NOTE: The user must click Apply for settings changes to take effect. 
The exact alarm settings window that appears depends on the type of device, as 
automatically detected by the software. Reference the device’s supplemental user 
manual for more information about specific alarms. 
The types of alarm settings windows are:  
 

• RS485 

• Profibus 

• DeviceNet/EtherCAT. 

• Foundation FieldBus 

• EthernetIP 

• GF40 

• GP200 

• GF1xx 
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Figure 11-22 Alarm Settings RS485 Window, Alarms Tab 
(exact alarms settings available varies depending on device type) 

 

 
Figure 11-23 Alarm Settings RS485 Window, Contact/Latch Tab  
(exact alarms settings available varies depending on device type) 
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*NOTE: For SLA device firmware prior to version 1.20, the Pressure Out of Limits Alarm Enable 
high and low are not independently settable. Either both are enabled or both are disabled 
(checking enable for one enables the other, and vice-versa). 

 
Figure 11-24 Alarm Settings Profibus Window  
(exact alarms settings available varies depending on device type) 

 
Figure 11-25 Alarm Settings DeviceNet/EtherCAT Window  
(exact alarms settings available varies depending on device type) 
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Figure 11-26 Alarm Settings (Field Bus), Alarms Tab 

 

 
Figure 11-27 Alarm Settings (Field Bus), Totalizers Tab 
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Figure 11-28 GF40 Alarm Settings, Alarms Tab 
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Figure 11-29 GF40 Alarm Settings Window, Contacts/Latch tab 
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Figure 11-30 GP200 Alarm Settings Window 

 
EthernetIP alarm status screens not shown for brevity. 

 
 
11.15 Restrictor Selection 

The Restrictor Selection window guides a user in changing settings for device 
restrictors (for devices that support this feature – SLA Rev B only). 
*NOTE: Restrictor selection is an advanced topic. Most users will not need to use this 
feature. A Pro license is required to use this feature. 
When you open the Restrictor Selection window, it shows the current restrictor part 
number, as well as all the valid restrictor selection options for your device. Each row 
in the grid represents a valid combination of settings with each restrictor part number. 
The current restrictor configuration is represented by the selected row in the grid. To 
select a new restrictor option, click on a new row to select it, then click Change (you 
must click Change for the change to take effect permanently). Click Optimal to allow 
the software to automatically choose the optimal restrictor (be sure that the model 
code is set correctly beforehand). Again, you must click Change for the change to 
take effect permanently. 
For custom combinations of restrictor part numbers and other model code parameters 
use the Model Code window or contact the factory. 
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Figure 11-31 Restrictor Selection Window 

11.16 Orifice Selection 
The Orifice Selection window guides a user in changing settings for device orifice 
configurations (for devices that support this feature – SLA Rev B only). This is similar 
to the restrictor selection. 
*NOTE: Orifice selection is an advanced topic. Most users will not need to use this 
feature. A license is required to use this feature. 
When you open the Orifice Selection window, it shows the current orifice part number, 
as well as all the valid orifice option selections. Each row in the grid represents a valid 
combination of settings with each orifice part number. The current orifice configuration 
is represented by the selected row in the grid. To select a new orifice option, click on 
a new row to select it, then click Change (you must click Change for the change to 
take effect permanently). Again, you must click Change for the change to take effect 
permanently. 
For custom combinations of orifice part numbers and other model code parameters 
use the Model Code window or contact the factory. 

 
Figure 11-32 Orifice Selection Window 
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Chapter 12 Device Control Menu 
The Device Control menu provides functionality to control a device with functions 
such as valve control, rebooting a device, and setting the device’s executing mode. 

 
Figure 12-1 DeviceControl Menu 

(executing mode appears only for supported devices). 

 
12.1 Reboot Device 

This window will allow a user to reboot a device. A reboot is similar to cycling the 
power to the device. If the user clicks reset, and confirms, the device will be reset and 
the device will remain attached to the software. 

 
Figure 12-2 Reboot Device Window 

12.2 Valve Control 
The Valve Control menu provides functionality to directly control a device’s valve. 
This is not available for meter (MFM) devices, as they do not have valves. 
If control is set to Analog (external), the software will ask if the user wants to set 
control to Digital (BEST) control. See Figure 11-2. 
In normal operation, a device’s valve may freely move up and down to regulate the 
flow or pressure of the controller device. However, the Valve Control feature allows 
the user to directly take control of the valve position. 
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Figure 12-3 Valve Control Window 

First, the user selects the desired valve control mode. The current valve control mode 
is shown on the window. 
Normal mode is when the valve automatically moves up and down to regulate flow or 
pressure. 
Open is when the valve is forced fully open. Closed is when the valve is forced fully 
closed. 
Manual is when the user can select a valve position from 0 to 100%. When manual is 
selected, the Manual Control box on the right side of the form becomes enabled. The 
user can view and set the valve position (the user must click the Set button or click 
Set on the Up/Down numeric control). 
The valve will then be held at this position. 
*NOTE: if the user is using an external controller (such as the Brooks 0254) and that 
controller has its valve override enabled, BEST’s valve control mode may not be able 
to change the mode or position. 
When the user closes this window, if the mode is not in normal mode, the software 
will ask the user if they want to set the mode back to normal before leaving the 
window, as a reminder. Normal mode is required for most other functions. 
For the VDM300 device, valve position (%) is replaced with Valve Current (mA). This 
current value is approximate. 
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12.3 Executing Mode 

If a device supports this feature, this menu allows a user to control the operating 
mode of device (executing mode, or Idle/Safestate). Some device types use “Idle” 
mode instead of “Safestate”. 
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Chapter 13 Calibration Menu 

The Calibration menu provides access to the process of calibrating and tuning a 
device. Customer devices are usually calibrated from the factory. However, BEST 
allows an advanced user to calibrate a device. 
A software license is required for most calibration functions. Reference Table 2-4 
through Table 2-9 to determine if calibration features are supported on your device. 
Both flow and pressure devices need to be calibrated for accurate control and 
measurement. The calibration menu includes functions for sensor zero, flow and 
pressure calibration, valve and response tuning, and analog input and output tuning. 
Calibration is the most complex aspect of BEST software. 
CAUTION: Some of the features contained within the Calibration menu can be used 
to alter the performance of the device. It is recommended that you save the device 
configuration before proceeding with any calibration or tuning function. For 
instructions on how to save the device configuration, refer to Section 11.2. 

 
Figure 13-1 Calibration Menu  
(exact options/features shown may depend on device type). 

*NOTE: Before conducting any calibration menu operations, verify the model code is 
set correctly (see Section 11.5). 

13.1 Pressure Controller Setup Diagram 
The Pressure Controller Setup Diagram menu displays a basic setup diagram for 
pressure controller and RT devices. The diagram shows typical setups for an 
upstream and a downstream application. These diagrams are from the device manual 
but are available directly from the software as a convenience. These are merely 
suggested/typical setups for reference – for detailed system analysis consult the 
device user manual or contact Brooks Instrument. 
The window also indicates the configured direction (upstream or downstream) of the 
current device (See Figure 13-2). 
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Figure 13-2 Pressure Controller Setup Diagram 

13.2 Sensor Zero 
The Sensor Zero menu guides the user through a sensor zero operation on either the 
device’s flow sensor or pressure sensor, depending on the device type. In most 
cases, the software automatically detects the device type and sensor type, and 
displays the appropriate form and performs the corresponding routine (flow and 
pressure sensor zero operations are different operations but the forms have a similar 
appearance). 
A sensor zero operation should be performed prior to a full calibration. See the device 
user manual. 

13.3 Flow Sensor Zero 
A flow sensor zero operation is performed for a MFC, MFM, or RT device (or possibly 
a PC device that has a flow sensor) in flow control mode. During the flow sensor zero 
operation there must be no flow through the device. During the zero operation, the 
operation reads the current sensor value, and offsets it so that the reading becomes 
zero. 

*NOTE: A flow device typically also includes a Zero pushbutton. The software 
performs the same function as the pushing that pushbutton. 

To zero the device’s sensor: 
1. Allow the device to be powered on for a sufficient length of time 
(reference the specific device manual) so that it achieves its 
stabilized operating temperature. 
2. Close the downstream shutoff valve, if present. 
The device should be full of process gas with no pressure differential. 
3. Wait at least 30 seconds for the flow signal to drop to zero. 
4. Using the device’s Zero pushbutton or the Brooks Expert Support Tool’s 
Sensor Adjust function, zero the device. 

If using the pushbutton, press the pushbutton, then release it. If using the software, 
access the menu item Calibration->Sensor Zero. 
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Figure 13-3 Flow Sensor Zero Window  
(Zero Drift History button appears only for EthernetIP devices). 

In the flow sensor zero window (Figure 13-3), the Actual Zero Value is the current 
(“live”) flow measurement of the flow sensor. The Flow Sensor Zero Correction is the 
current correction offset. The Flow Sensor State is “Idle” while the zero operation is 
not processing. 
With no flow present, click the Zero button. The state changes to “InProgress” while 
the zero operation takes place. The process may take up to 15 seconds. When 
completed, it returns to “Idle”. 
If you attempt to zero the device while gas is flowing at 5% of full-scale, a dialog box 
displays, prompt you to confirm whether you want to continue with the operation. 
*NOTE: For SLA devices, there is another way to access the flow sensor zero 
operation, under the Calibration->Calibration menu (see Figure 13-26). Both of these 
access methods perform the same flow sensor zero operation, except that the 
Calibration->Calibration menu method gives the user the option of performing a purge 
(opens the valve temporarily for 5 seconds) to relieve any trapped pressure. 
Zero Drift History: For SLA Rev B EthernetIP devices only, the Zero Drift History 
information may be viewed. The history report may be viewed, printed, and saved to a 
file. 
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Figure 13-4 Zero Drift History Window 

13.4 Pressure Sensor Zero 
A pressure sensor zero operation is performed for a PC device only.  

*NOTE: While an RT device does measure pressure, it measures pressure with an 
external (remote) pressure sensor connected to the device. This external sensor is 
not zeroed by BEST software - it is assumed that the sensor’s range (0-10V or 0-5V) 
represents its full specified range and that 0V = 0 pressure. see Section 13.7 for 
calibrating the range of this external RT sensor.) 
There are several ways to access the pressure sensor zero operation: the zero 
pushbutton, under this menu (Calibration->Sensor Zero) and for SLA devices, the 
Calibration->Calibration menu (see Section 13.16). These access methods perform 
different methods of sensor zero operation as explained below. 
A pressure controller’s pressure sensor can be calibrated in three ways:  

1.) Use the physical reset button on the device 
2.) A straight offset correction (BEST software, Calibration->Sensor Zero 
menu) 
3.) An interpolated correction (BEST software, Calibration->Calibration menu 
– see Section 13.16) 

A pressure device includes a zero pushbutton (located at the side of the device) that 
performs a straight offset correction. For pressure devices with a psia sensor, this 
zero is assumed to be at absolute zero pressure (0 psia) which requires a vacuum. For 
pressure devices with a psig sensor, this zero is assumed to be at ambient pressure 
(0 psig). 
The straight offset method for pressure controllers is similar to a flow sensor zero 
method. It is a simpler method than the interpolated method, but must be performed 
at reference pressure - under a vacuum for psia sensors or at ambient for psig 
sensors.  
The interpolated method can be performed for devices with a psia sensor. This allows 
a psia sensor to be zeroed without actually applying a vacuum, although it is a more 
complicated process. This method is performed under the Calibration->Calibration 
menu item (see Section 13.16). 
 
Simple Offset Zero 
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As this menu performs the simple offset method, it gives a warning for psia sensors. 
When the user clicks on the sensor zero menu (with a pressure controller device 
attached), the following warning is displayed: 

 
Figure 13-5 Sensor Zero Window for psia Pressure Device, PSIA Warning 

After this, the pressure sensor zero window appears (see Figure 13-6). From this point 
forward, the zero operation is straightforward and is the same as the flow sensor zero 
operation. 
 

 
Figure 13-6 Pressure Sensor Calibration (Straight Offset Method) 

Interpolated Zero Correction: see Section 13.16. 
13.5 Analog Output Calibration 

The Analog Output Calibration menu guides the user in calibrating (or “tuning”) the 
analog output of the device, if it has an analog I/O option. The analog output provides 
a DC voltage or current proportional to the flow or pressure reading of the device. The 
range and type of output is a device option. The Calibration->Analog Output menu 
allows the user to select the mode/range, check the adjustment, change the 
adjustment, and set the Low Output Cutoff. 
The Output Adjust window allows users to select the analog output mode and set 
output configuration parameters. 
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A typical setup for calibrating an output voltage is shown in Figure 13-7 and an output 
current in Figure 13-8. See your device’s user manual for specific information about 
your device. Contact Brooks Instrument to obtain a breakout board for easy 
connections. An alternative would be to use a device such as a Brooks Instrument 
Model 0254.  

 
Figure 13-7 Typical Setup for Calibrating an Output Voltage 

 
Figure 13-8 Typical Setup for Calibrating an Output Current 

The Low Output Cutoff is a percentage of full-scale reading below which the analog 
output is forced to zero volts. For example, if the Low Output Cutoff is set to 5% and 
an MFC device is reading 4% flow, the analog output will put out 0 volts. To disable 
this feature, set Low Output Cutoff to 0%. 
The user can change the Output Configuration mode by clicking on one of the five 
range buttons (if supported by the device). The current mode is shown in the Current 
Mode text box (See Figure 13-9). 
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The user can check the current analog output calibration by clicking on the Check 
button. Then the software will display another window (See Figure 13-10), asking the 
user to specify a voltage or current. Enter a voltage or current (within the range of the 
current analog output mode) and click Set. Then verify the voltage as read by an 
external measuring device (such as a multimeter or Brooks Instrument Model 0254 
controller). 

 
Figure 13-9 Analog Output Calibration Window 

 
Figure 13-10 Analog Output Check Window 
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Figure 13-11 Analog Output Cal, Low Point 

 
Figure 13-12 Analog Output Cal, High Point 

The user can calibrate the analog output by clicking on the Calibrate button. The 
calibration process causes the device to output voltage or current at two values, then 
performs an interpolation to calculate an offset and factor (or, “base” and “multiplier”). 
At each of the two points (low and high), read the voltage or current on an external 
measuring device, manually enter the value into the software window and click 
Accept. 
Afterwards, the Base and Multiplier values will be updated. 
The user may revert back to the original values of all parameters (when the Analog 
Output form was last opened) by clicking the restore button. 
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For SLA Rev B devices, select the mode before performing the calibration. Changing 
the mode after calibration may invalidate the calibration and require a re-calibration. 
For GF40 devices, the mode may be changed after calibration, if not changing the 
mode from voltage to current or vice-versa, without requiring a re-calibration. For 
GF40 devices, analog input and analog output modes must match. 

13.6 Analog Input Calibration 
The Analog Input Calibration menu guides the user in calibrating (or “tuning”) the 
analog input of the device, if it has the analog I/O option. If the device’s Control 
Source is set to Analog (see Section 8.4), the device responds to an analog input as 
either a DC voltage or current, changing its flow or pressure set point proportionally to 
the voltage or current. The range and type of input is a device option.  
The Analog Input Calibration menu allows the user to select the mode and range, 
check the adjustment, change the adjustment, set the Softstart Ramp Time, and set 
the Low Input Cutoff. 
The Input Adjust window allows you to select the analog input mode and set input 
configuration parameters. Before you begin, perform a sensor zero operation. 
Note: For MFC and MFM models, the 0 to 10 VDC analog input mode is only 
supported with the RS485 Analog customer interface and must be ordered with the 0 
to 10 VDC analog I/O mode option specified. 
A typical setup for calibrating the analog input for voltage is shown below in Figure 
13-13 and for current in Figure 13-14. See your device user manual for specifics 
about your device connections. Contact Brooks Instrument to obtain a breakout board 
for easy connections. An alternative would be to use a device such as a Brooks 
Instrument Model 0254. 

 
Figure 13-13 Typical Setup for Calibrating an Analog Input for Voltage 
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Figure 13-14 Typical Setup for Calibrating an Analog Input for Current 

The Low Input Cutoff is a percentage of full-scale reading on the analog input below 
which the device set point is forced to zero. For example, if the Low Input Cutoff is set 
to 5% and the analog input is at 4%, the set point will be set to 0. To disable, set Low 
Input Cutoff to 0%. 

The Softstart Ramp Time parameter allows user to ramp the set point in a certain time 
period specified in milliseconds (mS). For default behavior, set this parameter to 0 to 
allow for the fastest possible set point ramp time. 

The user can change the Input Configuration mode by clicking on one of the five range 
buttons. The current mode is shown in the Current Mode text box. 

The user can check the current analog input calibration by providing a voltage or 
current with an external source (such as a power supply or Brooks Instrument Model 
0254 controller) to the device’s analog input, then viewing the measured input “live” 
level in the Measured Input text box. 

*Note: Sometimes the valve may oscillate during the time between adjusting setpoint 
input base and multiplier. This is a normal event that will resolve itself immediately 
after setpoint input multiplier is adjusted. 

The user can calibrate the analog input by clicking on the Calibrate button. The 
calibration process prompts the user to supply external voltages or currents to the 
device’s analog input at two levels (high and low), then performs an interpolation to 
calculate an offset and factor (or, “base” and “multiplier”). 
At each of the two points (low and high), supply an external voltage or current as 
directed. The live voltage or current is shown in the Measured Input text box. Click 
Accept when ready each time. 
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Figure 13-15 Analog Input Calibration Window 

 
Figure 13-16 Analog Input, Low 
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Figure 13-17 Analog Input, High 

The user may revert back to the original values of all parameters (when the Analog 
Input form was last opened) by clicking the restore button. 
For SLA Rev B devices, select the mode before performing the calibration. Changing 
the mode after calibration may invalidate the calibration and require a re-calibration. 
For GF40 devices, the mode may be changed after calibration, if not changing the 
mode from voltage to current or vice-versa, without requiring a re-calibration. For 
GF40 devices, analog input and analog output modes must match. 
 

13.7 RT/Aux Input Calibration 
The RT/Aux Input Calibration menu guides the user in calibrating (or “tuning”) the 
auxiliary input of an RT device (SLA only). The auxiliary input of an RT device is 
normally connected to the external (“remote”) pressure transducer sensor. But for this 
calibration operation, the input is connected to variable power supply. This operation 
adjusts the input sensitivity to the sensor’s range (0 to 5V or 0 to 10V). 
The RT/Aux Input Calibration menu allows the user to select the range (0 to 5V or 0 
to 10V only), check the adjustment, and calibrate the input. 
The user can change the Input Configuration mode by clicking on one of the two 
range buttons. The current mode is shown in the Current Mode text box. 
The user can check the current analog input calibration by providing a voltage with an 
external source (such as a power supply) to the device’s auxiliary analog input, then 
viewing the measured “live” level in the Measured Input text box. 
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Figure 13-18 Typical Setup for Calibrating the RT Input  
(see your device user manual for specific connection information) 

 
Figure 13-19 RT/Aux Analog Input 
To test the device’s RT input, simulate the RT voltage using a variable voltage source 
and verify the Measured Input reading reported in this window. 
The user can calibrate the analog input by clicking on the Calibrate button. The 
calibration process prompts the user to supply external voltages to the device’s input 
at two points (high and low), then performs an interpolation to calculate an offset and 
factor (or, “base” and “multiplier”). 
At each of the two points (low and high), supply an external voltage as directed by the 
software. The live voltage or current is shown in the Measured Input text box. Click 
Accept when ready. 



Brooks® Expert Support Tool 

 

 

 
Figure 13-20 RT/Aux Analog Input Cal, Low 

 
Figure 13-21 RT/Aux Analog Input Cal, High 

13.8 Cal Pages 
The Cal Pages menu is where the user can select the active calibration page and 
delete pages. A “page” is a completely configured and calibrated set-up of the device. 
A page is created at the factory, or via the calibration process. A page is selected 
from the set of pages (the “calibration data set”) that have previously been created. 
For pressure controller devices, a page is also called a “pressure application”. 
Typically, this menu is of interest only to users who have a device with more than one 
calibration page stored in the device. 
Flow devices and pressure devices each have a separate set of possible pages and 
thus, different Cal Pages windows. There are separate menu items for flow pages 
and pressure pages (see Figure 13-22 and Figure 13-23). 
MFC and MFM devices have flow cal pages, PC devices have pressure pages, and 
RT devices can have both types. 
 

13.9 Flow Cal Pages 
The Cal Pages window for flow devices is shown in Figure 13-22. 
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Figure 13-22 Cal Pages Window, for Flow Devices 

The Surrogate Gas Pages section of this form is where the user can see the 
surrogate pages created as a product of the calibration process.  The average user 
rarely needs to be concerned with surrogate pages.  
To delete a surrogate page, select the page from the drop-down box, and click delete. 
*NOTE Exercise caution if deleting surrogate gas pages. 
The Process Gas Pages section of this form is where the user can view and select 
from the existing set of created calibration pages. To see the complete set of pages 
present in the device, click on the Process Gas Page drop-down box. 
The active page is prefixed with an asterisk in the Process Gas Page drop-down box. 
To activate a page, select one of the pages from the drop-down box, then click 
Activate. To view selected parameters of a page, select the page from the drop-down 
box, and the parameters are shown below the drop-down boxes. 
To delete a page, select the page from the drop-down box, and click delete. 
*NOTE: Exercise caution if deleting pages.  
To create a new flow page, use the full calibration process (Section 13.12). 

13.10 Pressure Cal Pages 
The Cal Pages (or “Application” Pages) window for pressure devices is shown in 
Figure 13-23. 
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Figure 13-23 Cal Pages Window, for Pressure Devices 

The Pressure Application Pages section of this form is where the user can view and 
select from the set of created pressure calibration pages. To see the complete set of 
pages present in the device, click on the Pressure Application Page drop-down box. 
The active page is prefixed with an asterisk. To activate a page, select one of the 
pages from the drop-down box, then click Activate. To view selected parameters of a 
page, select the page from the drop-down box, and the parameters are shown below 
the drop-down boxes. 
To delete a page, select the page from the drop-down box, and click delete. 
*NOTE Exercise caution if deleting pages. 
If the user has a license installed, they can create a default page (uncalibrated). 
To create a default page, click Create Default Page. A new window appears as shown 
in Figure 13-24. 
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Figure 13-24 Create Default Page Window, for Pressure Devices 

In this form, the Existing Pressure Pages section shows the existing pressure 
calibration pages, the same as in the previous form (but you can’t change the active 
page from here, this is just for viewing purposes). 
In the New Pressure Page block, it shows selected parameters that will be used in the 
new default page. For pressure controller devices, the Full-scale Range here must be 
<= the internal transducer range. 
Below that is the New Pressure Page Number drop-down box. The user can select a 
page number for the new page. 
To create the new page, click Create Default Page. If the user selected a page 
number that already exists, the user will be prompted whether they want to overwrite 
the existing page. Note that the “default page” that is created is not a calibrated page. 
To create a calibrated page from a previously created surrogate page, see Section 
13.12, to create a Customer Page. 
Once the new page is created, it will appear in the list of process gas pages. 

13.11 Calibration 
The Calibration menu is where the user can calibrate their devices for accuracy. The 
calibration procedure requires a license (see Section 5.1.2). 
Users can calibrate both flow and pressure devices, including RT devices. With 
supported devices, users can create multiple calibrations, stored in “pages” in the 
device (see Section 13.8). The user can then switch between calibrations by 
selecting pages. 
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Generally, the software automatically detects the device type and guides the user in 
the appropriate type of calibration to perform. The processes and windows that 
appear may be different, depending on the device type and calibration type. 
The calibration process typically involves the following steps: setting up a calibration, 
performing the calibration, validating the calibration, and producing calibration reports. 
To perform a calibration, the following conditions are required: 
- The device has been configured properly (including the model code). 
- The device has been sufficiently warmed up to achieve thermal stability (reference 
the device operation manual). 
- The sensor has been zeroed. 
- There is a supply of gas. 
- During the calibration process, the device must be in a thermally stable 

environment. Rapid or significant temperature changes during the calibration 
process can affect the device’s accuracy. 

- See also the device user manual. 
Calibrating a meter (MFM) device is very similar to calibrating a Mass Flow Controller. 
There are a few steps that are slightly different and are described in these instructions 
where needed. The main difference is to make sure you have a bench setup that can 
manually control and adjust the flow going through the meter device. See also 
Section 11.10 for instructions for simulating an MFC device with a meter for 
calibration purposes.  
*NOTE: Make sure that the model code information is set correctly prior to starting 
calibration (see Section 11.5). 

13.12 Flow Calibration 
Flow calibration is performed for MFC, MFM and RT device types. An example flow 
calibration window is shown in Figure 13-25. 
*NOTE: GF40 device calibration requires some additional steps. After reading this 
section, also read Section 13.13 for specific additional instructions. Also, there are 
some differences for calibrating the GP200 device – see Section 13.14 for details. 
For these device types, first read this section (Section 13.12) then read the section 
for your specific device type. 
For most devices, flow calibration is supported when the gas type used for calibration 
is different than the process gas type. Mixed gas calibration is also supported for SLA 
Rev B devices. 
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Figure 13-25 Flow Calibration Window 

At the top of the window is the DUT Information block. This information is read-only 
and is for informational purposes only. The Device Configuration text box is the model 
code. 
Below that are five tabs: Pre-Cal, Calibration, Surrogate Page, Customer Page, and 
Validation (See Figure 13-25). Typically, these tabs are executed in order from left to 
right. Select each tab by clicking on it. 
Pre-Cal Tab: The Pre-Cal tab is performed first. The Pre-Cal tab is shown selected in 
Figure 13-25. The Pre-Cal tab is not available for the GF1xx or GP200 device. 
Below the Pre-Cal tab are a number of user-editable entry fields. When the calibration 
window is first opened, these user-editable fields are initially populated from the 
model code (except for reference pressure and units which are set to the last user-
entered values). 
If the model code was set up correctly prior to entering the calibration window, for 
most users the data fields will already contain the needed data. 
However, in some calibration scenarios, the user may need to change these values. 
For example, some users may perform calibration with a gas that is different than 
their process gas (for example, a user may have a process gas of CO2, but may 
calibrate with N2). BEST software can accommodate these scenarios. The Pre-Cal 
tab information is for the calibration gas, so if the user’s calibration gas is different 
than their process gas, they will need to change this information to their calibration 
gas. 
*NOTE: The values entered in the Pre-Cal tab are for the calibration gas, not the 
process gas. 
When changing the parameters, the user typically changes the values from top to 
bottom (i.e., changes the Gas Symbol first, then Gas Range, etc.). 
Mixed-Gas Calibration: The user may calibrate with mixed gas in two ways: they 
may either:  
 
1.) do the full calibration with the actual mixed gas, or  
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2.) calibrate with a calibration gas (such as N2 or Air), utilizing a conversion factor for 
their process mixed gas. 
In scenario 1, the user will enter the mixed gas information in the Pre-Cal tab of the 
calibration window. Click on the Mix Gasses button. In the window that pops up (see 
Figure 13 26), ensure that the process gas page number is selected. Enter the mixed 
gas information (this information can be obtained from the Brooks Instrument web site 
or technical service). Then click Load. Then click exit. The pre-cal tab information will 
then be updated for using the mixed gas as the calibration gas. Note that the model 
code text box will be updated with the new gas code for mixed gas. 
In scenario 2, the user will enter the calibration gas information in the Pre-Cal tab of 
the calibration window. Mixed gas information will be entered later in the process. 
The user may then click Create Pre-Calibration Gas Page. 
*NOTE: Always double check all user-entered values before clicking the create page 
button. 
The software will warn the user that the create process will overwrite page (page 6 is 
reserved for the temporary Pre-Cal or “test” page). After a few moments, the pre-cal 
page will be created. The status bar will indicate success or failure of the page 
creation process. The process will also make page 6 the active page. 
After you have successfully created the pre-cal page, you can proceed to the next 
tab, by clicking on the Calibration tab. 
Calibration Tab: The Calibration tab is shown selected in Figure 13-26. 

 
Figure 13-26 Flow Calibration, Calibration Tab 

The Calibration tab performs a calibration using the temporary Pre-Cal page (page 6) as 
a starting point. The Calibration tab is performed after the Pre-Cal page is created. If 
the device has no Pre-Cal page (page 6), this tab’s calibration cannot be performed 
and the tab controls will be disabled. 
The Calibration tab is not available for the GF1xx or GP200 device. 
The user will use an external reference instrument to measure flow values and 
manually enter them into the calibration grid. 



Brooks® Expert Support Tool 

 

 

*NOTE: Before entering any measured data, ensure that your reference instrument’s 
reference temperature is set to the value shown on the Calibration tab, and that the 
instrument’s factor is set appropriately for the calibration gas. Also, you should zero 
your instrument with no flow, if necessary. 
The Zero Set Point button changes the device set point to 0% (useful if the set point 
list does not contain 0%) and stops the live measurements. 
The VGain (where supported) sets the approximate full-scale range. To check the 
value, click the StartMeas Button for 100% set point. Note the flow value shown by 
the external flow meter. If it is approximately at the nominal full-scale range, no 
adjustment is needed. If it is significantly different from the nominal full-scale value, 
an adjustment may be necessary. To adjust, change the value in the Sensor VGain 
numeric up/down control. To increase flow, decrease the gain value or vice-versa. 
You must click Save VGain to set the gain in the device. You may need to repeat this 
process until the full-scale flow is near the desired range, as it is a trial-and-error 
adjustment. The VGAIN adjustment is optional. If it is adjusted, it should be done 
before starting the grid measurements. (Vgain adjustment is not supported for some 
device types.) 
The Point Stabilize Delay value determines how much time delay occurs after clicking 
a set point button before the user may enter a flow value. This is to help prevent the 
user from entering a flow value before the flow has stabilized after changing a set 
point. The delay for the Calibration tab is always the same value as for the validation 
tab (see Validation Tab section below). 
The grid in the center of the Calibration tab is the calibration grid. Each row of this 
grid represents a set point. Each column represents a measurement at the set point. 
A number of set points will be measured and characterized to provide a correction for 
accuracy. 

 
Figure 13-27 Edit Setpoints Window 

The two set point columns represent the set point values in percentage (of full-scale) 
and absolute flow units. The number and values of the set points are user-
configurable.  
To change the set points, click on the Edit Points button. The Edit Setpoints window 
appears, as shown in Figure 13-27. For GF40 devices, the setpoints cannot be 
changed from their default. 
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Type in or edit a semicolon-separated list of set point percentages. Rules for the set 
point list are as follows: 
- Must be a semi-colon-separated list. 
- Number of points must be between 2 and 12. 
- All fields must be a numeric integer or floating point. 
- All numbers must be between 0 and 100. 
- List may not contain duplicate numbers (duplicate numbers are allowed on the 

validation tab). 
- Numbers must be incremental, left to right (non-incremental numbers are 

allowed on the on the validation tab). 
To set the list to its default set, click Default. 
When done, click Save, then Exit. The calibration grid now contains the new set of set 
points. 
The first row of the grid contains the titles of the columns. The second row contains 
the units for each column. The temperature units come from the Pre-Cal tab.  
The Zero Sensor button performs the same function as the Calibration- 
>Zero Sensor menu item (Section 13.2). The sensor should be zeroed prior to 
starting the calibration on the Calibration tab. 
The calibration of a setpoint is started by clicking on a Click button in one of the rows 
under the StartMeas Column. Clicking on one of these buttons starts a live 
measurement at the set point of the clicked row. The software will set the device’s set 
point to the value in the set point column, and then continually read the device’s 
output including flow, temperature, and valve position. 

 
Figure 13-28 Calibration Tab, Filled Out 

When performing this calibration with a meter type device, a pop-up window will 
appear, prompting the user to manually adjust the flow through the device (See 
Figure 13-29). Since meter devices do not have a valve, the user must adjust the flow 
manually in their system. Also, the Valve Position column will not show valid data for 
a meter device, of course. 
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Figure 13-29 Flow Cal, Meter Setpoint Prompt 

An external flow measuring instrument is required. The user will read the flow 
measurement from the external instrument and manually type it into the Actual Flow 
column. 
*NOTE: If the actual flow is not within 5% of the set point, the MFC output columns 
will turn red as a warning. When calibrating meters, take care to accurately manually 
adjust the flow rate (until the columns are no longer red). 
To go to another row (another set point), click a Click button in one of the other rows 
under the StartMeas Column. All rows must be filled out to continue the calibration 
beyond this tab. Set points can be completed in any order. 
To stop live measurements, click the Stop Meas button or click on another tab. 
When you have filled out the grid info for all set point rows, you should click Stop 
Meas. 
Then you can proceed to the next tab, by clicking on the Surrogate Page tab. 
Surrogate Page Tab: The Surrogate Page tab is shown in Figure 13-30. 

 
Figure 13-30 Flow Calibration, Surrogate Page Tab 

The surrogate page tab process uses the pre-cal page and the calibration data from 
the Calibration Tab to create another background page called the surrogate page. 
Once the surrogate page is created, multiple calibrations can be easily generated 
from this surrogate page without having to perform the whole calibration process 
again. 

The Surrogate Page tab is not available for the GP200 device. 
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Upon clicking on the Surrogate Page tab, if the PreCal page 6 does not exist in the 
device, the tab’s controls will be disabled. Then go back to the pre-cal tab to create a 
test page (page 6). 

After clicking on the Surrogate Page tab, it will show the device temperature, a default 
calibration pressure, the device’s current orientation, and the current user logged on to 
the computer. The user can change these parameters if desired – this info will be 
stored into the device. 

The user will select a surrogate page number. For most applications, choose page 1. 
For GF40 devices, page 1 is selected and cannot be changed. For Biotech devices, if 
the cal gas is N2 or Air choose surrogate page 1, or if the cal gas is CO2, choose 
surrogate page 2. 

To create the surrogate page, click the Create Surrogate Page button.  

When finished, click on the Customer Page tab. 
Customer Page Tab: The Customer Page tab is shown selected in Figure 13-31. 

 
Figure 13-31 Flow Calibration, Customer Tab 

The Customer Page tab creates calibration page in the device (based on the 
Surrogate Page created in the Surrogate Page tab) as a starting point. Multiple 
custom calibration pages can be created from the same surrogate page without 
having to repeat the full calibration. Pages may be created for a different gas than 
was used for the calibration.  
The Customer Page tab is performed after the Surrogate tab page is performed. If the 
device has no surrogate page, this tab’s calibration cannot be performed and the tab 
will be disabled. When the Customer Page tab is clicked, it is initially populated with 
values from the current device page, or if no device page exists, from the surrogate 
page. 
Below the Customer tab are a number of user-editable entry fields. When the 
Customer tab is selected, these user-editable fields are populated with the values 
from the device’s surrogate page (except for reference pressure and units which are 
set to the last user-entered values). 
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The user may use the existing data in the fields or, in some calibration scenarios, the 
user may need to change these values. For example, some users may perform 
calibration with a gas that is different than their process gas (for example, a user may 
have a process gas of CO2, but may calibrate with N2). The customer page is where 
the user enters the process gas (not the calibration gas) and its associated 
parameters. 
When changing the parameters, the user typically changes the values from top to 
bottom (i.e., change the Gas Symbol first, then Reference Temperature, etc.). 
*NOTE: Initially, the parameter values may or may not initially match the parameters 
from the model code. The user must make sure to enter the values that will be used 
for the process gas prior to creating the customer page (before clicking the Create 
Customer Page button). In most scenarios, the data values will be changed to match 
the model code, if necessary. 
As the user changes these values (and moves the cursor off a text box), the range 
value is automatically re-calculated, taking into account the other customer 
parameters in order to convert the range to its equivalent of the device. Finally, the 
user may manually change the range explicitly to the desired value. 
The user will select the Cust. Gas Page from the drop-down list for the page number 
where they want to store the new calibration. 

The user will select a surrogate page number (1 to 6 for most device types) from 
which the customer page (process page) will be generated. For most applications, 
choose page 1. For GF40 devices, page 1 is selected and cannot be changed. For 
Biotech devices, the user may need to choose page 1 or 2. 

 
     Table 13-1 Biotech Gas Page Restrictions 

Output Enhancements 
Model Code Option 

Process 
Page # Gas 

Surrogate 
Page# 

Normal (Code S or T) 1 N2 1 
Normal (Code S or T) 2 CO2 1 
Normal (Code S or T) 3 Air 1 
Normal (Code S or T) 4 O2 1 
Secondary (Code U or V) 1 N2 1 
Secondary (Code U or V) 2 CO2 2 
Secondary (Code U or V) 3 Air 1 
Secondary (Code U or V) 4 O2 1 

 

 
Mixed Gases: If the user’s process gas consists of a mix of gasses, the user may use 
BEST’s mixed gas set up. The user will need to obtain mixed gas parameter data on 
their mixture (contact Brooks Instrument). 
(Mixed gas is supported only for the SLA Rev B device). 
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Figure 13-32 Mixed Gas Data Entry Form 

Enter the data, including a custom name for gas mixture. Click Load and then Exit. 
The user is returned to the calibration window, Customer Page tab. Note the new 
value of the Cust. Gas Symbol and Cust. Gas Code. 999n is the code for mixed gas 
where n is the process page number (code 9999 is supported for heritage devices). 
The Cust Span Range may also change. Note that the model code text box will be 
updated with the new gas code for mixed gas. 
 

 
Figure 13-33 Flow Cal, Mixed Gas, Customer Tab 

Always be sure to double check all the entered data before clicking the Create 
Customer Page button. When all the data parameters are selected, the user is ready 
to click the Create Customer Page button. After the user confirms, the page will be 
created and activated.  
The user may create multiple pages. 
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Sensor Tuning Tab: 
The Sensor Tuning allows for Upstep and Downstep sensor tuning (for SLA Flow 
controller products only). 
Tu run the Sensor Tuning operation, follow the step-by-step instructions on the 
screen (in red). The user may select Upstep, Donwstep, or both. Click the Tune 
button to start. 
 

Figure 13-34 Sensor Tuning 
 
Validation Tab: The Validation tab is shown selected in Figure 13-35. 

 
Figure 13-35 Flow Calibration, Validation Page 

If the calibration gas and customer gas are the same gas, the validation is performed 
using the process gas. However, if the calibration gas and customer gas are different 
gasses, the validation is performed using the calibration gas.  
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The Validation tab performs a validation of a customer page’s calibration. The page 
verified is the current active page. It is assumed that the current page is the process 
gas page. The Customer page was created in the Customer Page tab. The Validation 
tab is performed after the Customer page is created. If the device has no customer 
page, this tab’s validation cannot be performed and the whole tab will be disabled. 
The grid in the center of the Calibration tab is the validation grid. Like the calibration 
grid, each row of the validation grid represents a set point. Each column represents a 
measurement at a set point. A number of set points will be measured and checked for 
accuracy. 
The set point columns represent the set point values in percentage and absolute flow 
units. The number and values of the set points are user- configurable. The set of 
validation points does not need to match the set of calibration points. To change the 
set points, click on the Edit Points button. The Edit Setpoints window appears, as 
shown in Figure 13-27, the same way as for calibration set point selection. 
The Point Stabilize Delay value determines how much time delay occurs after clicking 
a set point button before the user may enter a flow value. This is to prevent the user 
from entering a flow value before the device has stabilized (in terms of flow control) 
after changing a set point. The delay for the Validation tab is always the same value 
as for the Calibration tab (see Calibration Tab section above). 
The first row of the grid contains the titles of the columns. The second row contains 
the units for each column.  
Like the calibration tab, the validation for a set point is started by clicking on a Click 
button in one of the rows under the StartMeas Column. The software will set the 
device’s set point to the value in the set point column, and then continually read the 
device’s output including flow, temperature, and valve position. See Figure 13-35. 
*NOTE: When performing this validation with a meter device (MFM), a pop-up 
window will appear, the same one that appears for the Calibration tab, prompting the 
user to manually adjust the flow through the device (See Figure 13-29). Since meter 
devices do not have a valve, the user must adjust the flow manually in their system. 
Also, the Valve Position column will not show a valid value for meter devices. 
*NOTE: If the actual flow is not within 5% of the set point, the MFC output columns 
will turn red as a warning. When calibrating meters, take care to accurately manually 
adjust the flow rate (until the columns are no longer red). 
*NOTE: The accuracy calculation is the comparison of the expected flow and external 
actual measurement. The pass/fail criteria (red or green) is based on the percentage 
of full-scale for all points. 
Like the calibration tab, in the validation tab the user must enter the actual flow into 
the Actual Flow column, the column with a yellow background. An external flow 
measuring instrument is required. The user will read the flow measurement from the 
external instrument and manually type it into the Actual Flow column. 
*NOTE: Before entering any measured data, ensure that your reference instrument’s 
reference temperature is set to the value shown on the Validation tab, and that the 
instrument’s factor is set appropriately for the calibration gas. 
To go to another row (another set point), click a Click button in one of the other rows 
under the StartMeas Column. All rows must be filled out with valid numeric data to 
complete the validation and create a certification sheet (see Section “Create Cert” 
below). Set points can be completed in any order. 
Once a user types in an actual flow value, the error percentage is automatically 
calculated and updated for the current row (current setpoint). 
Clicking the Validate Accuracy button stops live measurements and recalculates the 
accuracy for all set points (all rows). The accuracy calculation compares the target set 
point/flow rate to the (manually entered) external meter value. 
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At any time, to stop live readings, click the Stop Meas button. 
The Zero Set Point button stops live measurement and changes the device set point 
to 0% (useful if the set point list does not contain 0%). 
When you have filled out the grid info for all set point rows, you should click Stop 
Meas. Then, if desired, you can proceed to create a cal sheet report (see next 
section). 
*NOTE: If your calibration gas is different than your process gas, see also the sub 
section below “Calibrating when the calibration gas and process gas are different.” 
Create Cal Sheet: Once the validation is completed, the user can print out a 
calibration sheet. This is a report showing the validation results data and some 
custom user information. 
Click the Create Cal Sheet button. A window will open showing a pre-selected set of 
configuration data. It also allows the user to choose a set of custom configuration 
data items that will appear on the report, in addition to the calibration data. The user 
may select, edit, and save the set of custom configuration data for the report (See 
Figure 13-36). 
The fields with a white background are initialized with values from the device or 
software. Fields with a yellow background are initialized with values from a user 
profile. A user profile is a set of user-selected values that are stored so that the user 
does not have to repeatedly type in the same values. The user saves a set of values 
in a profile, creates a profile, and selects a profile. The fields with a gray background 
cannot be changed by the user. The user may also select the image that appears on 
the footer of the report. The user may choose the default or may provide their own 
logo. 
The user may also select the number of decimal places that appear in the tabular 
data on the report, via the Decimal Places box. 

 

 
Figure 13-36 Flow Cal, Cert Sheet Preview Page 

After this, click Generate Report and a preview of the report information will be 
displayed. 
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Figure 13-37 Flow Cal, Cert Sheet 

From there, the user may view, print or save the report to file. 

 

Calibrating when the calibration gas and process gas are different: In some 
scenarios, the user may need to calibrate for their process gas, but may not be able 
to use their actual process gas for calibration (for example when the process gas is 
expensive or hazardous). In this case, BEST supports the calibration/validation using 
a calibration gas that is a different gas than the process gas (For example, the 
process gas is CO2, but the calibration gas is N2). In BEST, the validation may be 
performed using either the calibration gas or the process gas. However, for the 
GP200 device, the validation can only be performed with the process gas. 

For this scenario, the calibration process is similar, but there are a few differences. 
The differences are in the Validation process in the Validation tab). 
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*NOTE: When first starting the calibration process, make sure the model code is set 
correctly before starting the calibration. The model code must be set to the process 
gas settings, not the calibration gas settings. 

When the user creates the process page (in the Customer Page tab), they will select 
the process gas. But then, the validation may be performed with either the process 
gas or the calibration gas. After the user creates the process page with a gas that is 
different from the calibration gas, and then clicks on the Validation tab, the grid will 
have two additional columns. 

 
Figure 13-38 Validation Tab when cal gas and process gas are different 

Now, there are two columns for setpoint in flow units, one in the calibration gas 
equivalent, and one in the process gas equivalent (the gas symbols are shown for 
each column in the header row). Similarly, there are two columns for actual flow in 
flow units, one in the calibration gas equivalent, and one in the process gas 
equivalent (the gas symbols are shown for each column in the header row). 

Validation is performed with a process that is similar to the process if the calibration 
gas and process gas were the same. The difference is that the user will enter the 
measured flow in either one of the actual flow columns (with a yellow background), 
depending on which gas they are using to validate. In our example, if they are 
validating with CO2 (process gas), they will enter their values in the Actual Flow 
column labeled for CO2. Alternatively, if they are validating with N2 (calibration gas), 
they will enter their values in the Actual Flow column labeled for N2. After the user 
enters the value, the equivalent flow value for the other Actual Flow column will be 
calculated automatically. 

The error/accuracy calculation will always be based on the actual flow from the 
process gas column. Likewise, the data for the cal sheet will always be based on the 
actual flow from the process gas column. 
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13.13 GF40 Device Flow Calibration 
Flow calibration for GF40 devices is similar to flow calibration as described in Section 
13.12, but with the differences listed in this section (Section 13.13). If you haven’t 
already done so, read Section 13.12 before reading this section.  

 
Figure 13-39 Calibration, Pre-Cal Tab, GF40 

Pre-Cal Tab: For GF40 devices, Pre-Cal may be done at around 160% of the bin 
range for some bins, depending on the range. The gas is always N2, and the flow 
units are always SCCM. The bin and range are shown in the Device Configuration 
text box as part of the model code. 

*NOTE: For GF40 devices, calibration is always performed with nitrogen gas, even if 
the process gas is not nitrogen. 

 
Figure 13-40 Calibration, Calibration Tab, GF40 

Calibration Tab:  The Calibration tab operation is the same as in Section 13.12, 
except that the calibration set points profile is not editable. 

Surrogate Page Tab:  The Surrogate Page tab operation is the same as in Section 
13.12. 
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Customer Page Tab: The Customer Page tab is created with the user’s desired final 
flow range, units, and gas, the same as in Section 13.12. 

 
Figure 13-41 Calibration, Customer Page Tab, GF40 

Validation Page: The validation step has an additional step compared to Section 
13.12. Notice that there is an additional button at the bottom of the page: Create 
Validation Page. 

 
Figure 13-42 Calibration, Create Validation Page, GF40 

Click the Create Validation Page button. This will create an additional page in the 
device called a “Validation page”. This is the page that will be used to validate the 
device’s calibration. This page will be set up to measure the flow range at set points 
up to the 100% of the bin range at the Nitrogen equivalent flow. 

*NOTE: For GF40 devices, validation step is always performed with nitrogen, even if 
the process gas is not nitrogen. Thus, it is required to create the validation page. This 
validation page will be created at 100% of the bin range, regardless of the customer 
page range. 
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After you click the Create Validation page button, choose a blank page number (2 by 
default) – be careful not to choose the customer page you just created in the previous 
step. After the new validation page is created, that page will be activated, and that is 
the page on which the next step of validation will be performed. The validation grid 
may be re-oriented to match the new scale of the new validation page. Notice in the 
Current page text box, that page 2 is now activated and ready for validation. 

 
Figure 13-43 Calibration, Validation Tab with Validation Page, GF40 

Next, you will continue to perform a validation (using nitrogen) as usual (as described 
in Section 13.12).  

 
Figure 13-44 Calibration, Validation Tab, Validation Page with Data, GF40 

Cal Sheet: You may create a cal sheet for a GF40 device if desired, in the same 
ways as with an SLA device in Section 13.12. However, the usual practice for GF40 
devices is to produce a cert sheet. 

Cert Sheet: A cert sheet may be produced for a GF40 device by clicking the Print 
Cert button. The Cert Sheet Report Window will appear. From here the report can be 
printed or saved. Click Exit to return. (For cal setpoint data to appear on the label, the 
data must be present on the Validation tab.) 
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Figure 13-45 Cert Sheet Report Window 

Print Device Label: A device label may be produced for GF40 device by clicking the 
Print Cert button. The Cert Sheet Report Window will appear. From here the report 
can be printed or saved. Printing the report does not save a copy. Click Exit to return. 
(For cal setpoint data to appear on the label, the data must be present on the 
Validation tab.) 
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Figure 13-46 Device Label Report Window 

This label template is designed for label stock Brooks Instrument part number 
502Y713, which is die cut to support several different sized labels simultaneously (for 
the side and edge of the device can) and contains the Brooks Instrument logo. Label 
printing using other label stock (and with other logos) is theoretically possible. 

 

13.14 Warp 
For GP200, GF40, and GF1xxx devices, an adjustment called “Warping” allows a 
user to adjust the device’s response to match their standard, such as within a certain 
environment.  

The user enters performance data of their device as measured in their environment, 
then the software uses a curve fit to adjust the device’s response accordingly. 

Warping requires a license. 

For GP200 devices, a warp adjustment is added to the device’s factory calibration, 
and can be cleared from a flow page without affecting the factory calibration. The 
same flow page may then be used again without the warp adjustment. 

On the other hand, for GF1xx devices, once a warp adjustment is applied to a flow 
page, the warp adjustment cannot be cleared/undone and the flow page cannot be 
restored to its previous state. It is recommended that warping not be applied more 
than four times to any flow page. At that time, you must delete the page and create a 
new one, then apply a new warp if desired. 

Print 
Page Setup 

Export (Save As) 

Print Layout (Print Preview) 
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Figure 13-47 Warp (GP200) 

 
Figure 13-48 Warp (GF) 
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13.15 Bin Select (GF) 

The Bin Select (GF) window is used to determine what bin is required for a specific 
device type, gas, outlet pressure, flow range, and reference temperature.  

Bin selection is for GF devices only (GF40 and GF1xx). The Bin Select window may 
be opened regardless of whether a device is attached or not. If a device is attached, 
the window will open with that device type pre-selected. 

 
Figure 13-49 Bin Select (GF) Window 

13.16 Pressure Controller Calibration 
Pressure controller calibration is performed for PC device types (this is not performed 
for RT devices). The process is similar to the flow calibration process, although less 
complex. An example pressure calibration window is shown in Figure 13-50. 

 
Figure 13-50 Pressure Calibration Window, Cal Setup Tab Shown 
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At the top of the window is the DUT information block. This information is read-only 
and is for information purposes only.  
Below that are the tabs: Cal Setup, Orifice, Calibration, Linearization Page, Customer 
Page, and Validation. These tabs are normally executed in order from left to right. Select 
each tab by clicking on it. 
Cal Setup Tab: The Cal Setup tab is performed first. The Cal Setup tab is shown 
selected in Figure 13-50. 
Below the Cal Setup tab are a number of data fields. Most of these fields are read-
only and are obtained from the device and its model code. 
The Transducer Full-scale Pressure and its units are the rated value of the device’s 
internal pressure transducer and can’t be changed. The initial calibration steps will be 
performed for the full range of the pressure transducer. Later in the process, a 
pressure page may be created at a lower pressure value. 
*NOTE: Make sure the model code has been set up correctly prior to starting the 
calibration (see Section 11.5). 
Mixed Gas: An SLA Rev B pressure controller device may be calibrated for a mixed 
gas. Click on the Mixed Gas Values button. A Mixed Gas Data Entry Form will open 
(reference Figure 13-32). This is the same form used with mass flow controller 
calibration for mixed gasses. Click on the Mixed Gas Values button, then enter the 
mixed gas information.  Click load then Exit. Note that this may change the model 
code text box’s gas code. Click on the Mixed Gas Values button before clicking the 
Create Pre-Calibration gas Page button.   
 
The user will then click Create Pre-Calibration Gas Page. This will create an initial, 
temporary pressure calibration page to be used later in the calibration process.  
Then the user is asked if they want to over-write the Pressure Response Tuning 
attributes with default values. These are values in the device, in the current page, that 
may have been previously set during a valve tuning operation for the current page. If 
the user had previously done a valve tuning operation (which creates these 
attributes), they may want to preserve those values. Click No to copy the current 
values from the current page to the new page 6 and continue with the calibration. 
Click Cancel to cancel the process. Or, click Yes to write default values to the new 
page 6 and continue with the calibration. 
After clicking the Create Pre-Calibration Gas Page button, the page is created as 
page 6, and that page is activated as the current page. 
Next, click the Orifice Tab. 
Orifice Tab: The orifice tab is used as an aid in calculating the orifice factor and 
adjusted flow range when the gas used for valve tuning is different than the process 
gas. If the gas used for valve tuning is the same as the process gas, this tab may be 
ignored. 
This tab is initially populated with process gas values from the device’s model code. 
The user should edit their calibration gas values under the calibration text block. Then 
click the Calc Orifice Factor and Range button. 
The orifice factor and equivalent adjusted flow range will be calculated, as well as the 
gas densities of the gasses. The new orifice factor and equivalent adjusted flow will 
eventually appear on the cal sheet. 
*NOTE: You must click the calculate button to recalculate the values. 
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Figure 13-51 Pressure Calibration, Orifice Tab 

 
Figure 13-52 Pressure Calibration, Calibration Tab 

Calibration Tab: The Calibration tab for pressure calibration is shown in Figure 
13-52. 
The Calibration tab performs a calibration using the Pre-Cal page (created in the 
previous tab) as a starting point. The Calibration tab is performed after the Pre-Cal 
page is created. If the device has no Pre-Cal page (page 6), this tab’s calibration 
cannot be performed, and the tab will be disabled. 
The Point Stabilize Delay value determines how much time delay occurs after clicking 
a set point button before the user may enter a pressure value. This is to prevent the 
user from entering a pressure value before the flow has stabilized after changing the 
set point. The delay for the Calibration tab is always the same value as for the 
validation tab (see Validation Tab section below). 
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The set point columns represent the set point values in percentage and absolute 
pressure units. The number and values of the set points are user- configurable. To 
change the set points, click on the Edit Points button. The Edit Setpoints operation is 
the same as for the flow calibration, except that for pressure calibration, it is 
recommended that all set points be <= 80%. For pressure calibration, two or three 
points is usually sufficient. The set of calibration points does not need to match the 
set of validation points. 
In some scenarios, you may need to calibrate to a pressure range that is lower than 
the full range of the device’s installed pressure transducer. For example, your system 
only supplies up to 1500 psi, but you have a device with a 3000 psi transducer. Or, 
you have device with a 3000 psi transducer, but the device’s valve is only rated to 
1500 psi. In either case, you would need to limit the calibration of the device to 1500 
psi. You can do this by changing the setpoints so that the highest set point is at 50% 
(1500 / 3000 psi). 
The grid in the center of the Calibration tab is the calibration grid. Each row of this 
grid represents a set point. Each column represents a measurement at the set point. 
A number of set points will be measured and characterized to provide a correction for 
accuracy. 
The first row of the grid contains the titles of the columns. The second row contains 
the units for each column. The pressure units are from the Cal Setup tab selection. 
The temperature units come from the model code. 
Sensor Zero: If you intend to use the interpolated version of the sensor zero 
operation, you must do so before measuring any of these set points. After opening 
the Calibration window and clicking on a set point for the first time, a reminder for the 
sensor zero will appear. This will ask if you want to perform a sensor zero operation. 
If you click “Yes”, the set point will not be measured, giving the user an opportunity to 
click on the Zero Sensor button. Clicking “No” will continue with the set point setup 
and will not again remind the user (until the calibration window is closed and re-
opened). 
Clicking the Zero Sensor button on the calibration window will perform the 
interpolated pressure sensor zero operation. The interpolated method is the preferred 
method. 
The interpolated pressure sensor zero operation will measure two points along the 
range of the sensor. The points for a zero operation are at 80% and 0% of the full-
scale transducer range. These two points will be used in a linear interpolation to 
calculate the offset correction at absolute zero pressure (0 psia). 
First, the operation prompts the user to set up their system for calibration, including 
pressure and vacuum on the inlet and outlet, as needed. The setup requires an 
external pressure meter instrument as well. 
Next, at the high point the software prompts the user to set up the pressure. The 
window shows the live reading of device pressure and valve position for reference. 
The user is instructed to read the external meter and manually enter the pressure 
value (in user’s units) onto the form. (See Figure 13-53). 
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Figure 13-53 Pressure Sensor Zero, High Point 
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Figure 13-54 Pressure Sensor Zero, Low Point 

Next, at the Low point (0%) the software prompts the user to set up the pressure to 
0% pressure. The window shows the live reading of device pressure and valve 
position for reference. The user is instructed to read the external meter and manually 
enter the pressure value (in user’s units) onto the form. (See Figure 13-54). 
After this, a final measurement at zero pressure again will be presented in the same 
manner, for a final, corrected measurement at zero pressure. This completes the 
pressure sensor zero operation.  
Next, after the sensor zero operation, the calibration setpoints can be measured. 
The calibration is started by clicking on a Click button in one of the rows under the 
StartMeas Column (see Figure 13-55). Clicking on one of these buttons starts a live 
measurement at the set point of the clicked row. The software will set the device’s set 
point to the value in the set point column, and then continually reads the device’s 
output including pressure, temperature, and valve position for reference.  
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Figure 13-55 Pressure Calibration, Calibration Tab 

The user must manually enter the actual pressure into the Actual Pressure column, 
the column with a dark yellow background. An external pressure meter is required. 
The user will read the pressure measurement from the external meter and manually 
type it into the Actual Pressure column. 

To go to another row (another set point), click a Click button in one of the other rows 
under the StartMeas Column. All rows must be filled out to continue the calibration 
beyond this tab. Set points can be completed in any order. 

To stop live readings, click the Stop Meas button. 

The Zero Set Point button changes the device set point to 0% (useful if the set point 
list does not contain 0%) and stops the live measurements. 

When you have filled out the grid info for all set point rows, you should click Stop 
Meas. Then you can proceed to the next tab, by clicking on the Linearization Page 
tab. 

Linearization Page Tab: The Linearization Page tab is performed next. The 
Linearization Page tab is shown in Figure 13-56. 
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Figure 13-56 Pressure Calibration, Linearization Page Tab 

Click the Create Linearization page button to create the linearization page. The 
linearization is saved to page 6 and that page becomes the active page. 
Customer Page Tab: The Customer Page tab is performed next. The Customer 
Page tab is shown in Figure 13-57. 

 
Figure 13-57 Pressure Calibration, Customer Page Tab 

The Customer Page tab is where the user can customize some settings. The 
Customer Page uses the linearization page (page 6, created in the Linearization Page 
tab) and creates a user-specified “customer page”. Multiple customer pages can be 
created from the same linearization page without performing a full calibration again. 
The Customer Full-Scale Pressure is the pressure to be used for the final full-scale 
pressure on the device (after page creation). This value can be at the transducer full-
scale pressure, or lower. The Customer Pressure Units drop-down box is user-
selectable. 
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The Customer Page Number can be any number from 1 to 6. It is recommended that 
you not select page 6 to preserve the linearization page for future use in creating 
other new pages, if desired. However, if you are done with page 6 you may overwrite 
it at this point if desired. 
The tuning values block contains the tuning values presently in the device. These can 
be changed here if desired. However, if these values need to be changed, they would 
typically be changed during a response tuning operation (see Section 13.18). 
Clicking Create Customer page creates the page as the page number selected. That 
page number will be active afterwards. 
Validation Tab: The Validation tab is shown selected in Figure 13-58. 

 
Figure 13-58 Pressure Calibration, Validation Tab 

The Validation tab performs a validation of a customer page’s calibration. The page 
verified is the current page (see Section 13.10 to select a page). It is assumed that the 
current page is the customer page. The Customer page was created in the Customer 
Page tab. The Validation tab is performed after the Customer page is created. If the 
device has no customer page, this tab’s validation cannot be performed and the whole 
tab will be disabled. 
The grid in the center of the Calibration tab is the validation grid. Like the calibration 
grid, each row of the validation grid represents a set point. Each column represents a 
measurement. A number of set points will be measured and checked for accuracy. 
The set point columns represent the set point values in percentage and absolute 
pressure units. The number and values of the set points are user- configurable. To 
change the set points, click on the Edit Points button. The Edit Setpoints window 
appears, the same way as for calibration set point selection (see Figure 13-27 to set 
the collection of set points). 
The Point Stabilize Delay value determines how much time delay occurs after clicking 
a set point button before the user may enter a flow value. This is to prevent the user 
from entering a flow value before the flow has stabilized after changing a set point. 
The delay for the Validation tab is always the same value as for the Calibration tab 
(See Calibration Tab section above). 
The first row of the grid contains the titles of the columns. The second row contains 
the units for each column. The pressure units are the user’s preference from the 
Customer Page tab and temperature units are from the device’s model code. 
Columns without units are unit-less or ratio values. 
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Like the calibration tab, the validation for a set point is started by clicking on a Click 
button in one of the rows under the StartMeas Column. Clicking on one of these 
buttons starts a live measurement at the set point of the clicked row. The software will 
set the device’s set point to the value in the set point column, and then continually 
read the device’s output including pressure, temperature, and valve position. 
Like the calibration tab, in the validation tab, the user must manually enter the actual 
pressure into the Actual Pressure column, the column with a dark yellow background. 
An external pressure meter instrument is required. The user will read the pressure 
measurement from the external meter instrument and manually type it into the Actual 
Pressure column. 
To go to another set point, click a Click button in one of the other rows under the 
StartMeas Column. All rows must be filled out to complete the validation and create a 
certification sheet. Set points can be completed in any order. 
Once a user types in an actual pressure value, the error percentage is automatically 
calculated and updated for the current row. The accuracy calculated is the set point 
pressure compared to the actual, external pressure reading. 
Clicking the Validate Accuracy button stops live measurements and recalculates the 
accuracy for all rows (all set points). 
At any time, to stop live readings, click the Stop Meas button. 
The Zero Set Point button stops live measurement and changes the device set point 
to 0% (useful if the set point list does not contain 0%). 
When you have filled out the grid info for all set point rows, you should click Stop 
Meas. Then, if desired, you can proceed to print a certification report, (see next 
paragraph). 
Create Cal Sheet: Once the validation is completed, the user can print out a cal 
sheet. This is a report showing the validation results data and some custom user 
information. 
Click the Cal Sheet button. A window will open allowing the user to choose a set of 
custom data items that will appear on the report, in addition to the validation data. The 
user may select, edit, and save the set of custom report data (See Figure 13-59). 

 
Figure 13-59 Pressure Calibration, Cert Sheet Options Window 

After this, a preview of the report information will be displayed. 
From there, the user may view, print or save the report to file. 
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Figure 13-60 Pressure Calibration, Cert Sheet Preview Window 

13.17 RT Device Calibration 
The flow calibration process for an RT device is exactly the same as for an MFC 
device, with only a few minor exceptions. 
RT devices may be operated in pressure control mode. However, the semi-automated 
calibration process consists of temporarily placing the device into flow control mode 
for calibration purposes, (which makes the device simulate an MFC). This allows the 
RT device to use its internal valve to help calibrate for accurate flow measurement. 
Then, after calibration, it may switch the device back into pressure control mode. 
For an RT device (which uses an external pressure sensor), there is no pressure 
control calibration process or pressure sensor zero process, other than the 
RT/Auxiliary Input adjustment (see Section 13.7). 
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At the end of the (flow) calibration process for RT device, an opportunity is made 
available for the user to create a default pressure page if necessary. The Pressure 
Application page selection window is brought up. (See Figure 13-61). The user should 
ensure that at least one pressure page exists. If none exist, the user may create a 
new page by clicking the Create Default page button, then selecting the range and 
units they desire that corresponds to maximum voltage from the RT external pressure 
sensor. The user also selects a pressure page number. 
Then the user should also perform the RT/Auxiliary Input adjustment (see Section 
13.7). 

 
Figure 13-61 Pressure Page Window 

13.18 Response Tuning (Flow) 
The Response Tuning menu is where the user can optimize the timing response of 
the valve. MFM devices do not have a valve, so response tuning is not applicable. 
Response tuning optimizes the dynamic response of the device to changes in set 
point. You can use this feature to eliminate undesired under-and overshoot. 
Users can tune valves on either flow or pressure control devices. The process is very 
similar for both. Flow devices (MFC’s) are tuned in flow control mode, and pressure 
devices (PC’s) are tuned in pressure control mode. RT devices may be tuned in either 
mode: first select the mode (Device Control->RT Control Mode menu). This section 
describes the process for response tuning for flow controllers. The following section 
describes the process for response tuning for pressure controllers. 
*NOTE: For devices calibrated at the factory, response tuning adjustments should 
typically not be necessary, as calibrations are performed to the device’s specified 
process conditions. If you do want to adjust the response tuning, it is strongly 
recommended that you only adjust the PID Kp and Ki (proportional and integral gain). 
Only in rare occasions the Kd1 and Kd2 (derivative gain) values might improve 
performance. Make sure that you have saved the device configuration prior to 
adjusting these values. For Brooks Expert Support Tool training, which includes 
training for response tuning, contact your local Brooks service representative. 
Pedestal Tuning: The valve tuning process typically starts with pedestal tuning. 
Tuning the pedestal sets the valve’s offset and has a great effect on the response to a 
set point change. 
The way of calculating the pedestal value is different for normally closed and normally 
open valves. 
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For MFC and RT devices, the basic procedure for finding the pedestal value is to find 
the valve drive value at the point where the device starts flowing gas. This can easily 
be done with MFC and RT devices; however, for a PC device, it is more complicated. 
For an MFC or RT device, you configure a set point of 1%. If the device has a wrong 
pedestal, it might take some time for the device to reach the 1% flow. You might be 
able to speed this up by first configuring a set point of 10% and then going down to 
1%. 
For a pressure controller, configuring a set point will not work. You have to use the 
manual valve control mode in the Device Control -> Valve Control menu. Find the 
point at which the device starts flowing gas using the valve position field. Use an 
external flow meter to measure the flow and try to get down to ~1% of the maximum 
flow of the pressure controller at a low pressure. 
If the device has a normally closed valve (i.e., closed when unpowered), the pedestal 
is equal to the valve drive in percent at 1% flow, minus 7%. If the device has a 
normally open valve (i.e., opened when unpowered) the pedestal is equal to the 
inverse of the valve drive in percent at 1% flow, plus 7% (100% -’valve drive in %’ -
7%). 
Valve Tuning: The valve tuning process typically involves cycling the flow or pressure 
between a high and a low set point value, while watching and adjusting the 
parameters that control the response of the valve. The objective is to minimize 
overshoot and undershoot. 
To tune the device’s response, you will set up a square wave for the set point. You will 
then make adjustments to tuning parameters to make the actual flow graph match the 
set point’s square wave. 
The user will open the main graph window (see Section 8.4) and start the monitoring. 
For valve tuning, it is recommended that you choose % as your units of display for 
setpoint, pressure and flow. Make sure the graph can display your range of flow 
values (Settings->Graph Options menu). 
Then the user will open the Calibration->Valve Tuning menu and make adjustments 
there while watching the performance on the main graph. Position the Graph window 
so that you can see the Tuning and Graph windows at same time. 
The flow response tuning setup window is shown in Figure 13-62 and the pressure 
controller valve response tuning setup window is shown in Figure 13-63. 

 
Figure 13-62 Flow Response Tuning Setup Window 
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Figure 13-63 Pressure Response Tuning Setup Window 

Set up the set point square wave in the Cycling block of the Tuning window. Pick high 
and low set points that are at the expected range of your process application. 
The Cycling block in this window allows the user to select parameters determining the 
high and low set point of the cycling. The Switching time determines how often the set 
point changes state during the cycling. Choose a switching time that allows enough 
time for the flow response to settle after the setpoint changes. The Start button starts 
the cycling and the Stop button stops the cycling. 
*Note: If you are adjusting a meter model (MFM), use a separate flow controller to 
regulate the set point cycling. 
Apply gas flow to your device. 
Click the Start button to begin cycling. 
Observe how closely the actual flow matches the set point square wave. Start making 
adjustments using the PID Kp and Ki (proportional and integral gain) values. 
The Status block of the valve response tuning form shows the status during the 
cycling. 
Start making adjustments using the PID Kp and Ki (proportional and integral gain) 
values. (Do not adjust the Flow Control K-up and K-down values.) The Adjustments 
block is where the adjustments are made during the cycling. When changing values, 
always remember to click Apply. 
If you are having difficulty getting the actual flow graph to look like the setpoint square 
wave, you can restore the initial settings that were in effect when the window was 
opened by clicking the Restore Settings button. 
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Figure 13-64 Flow Valve Tuning Operation 

Effect of Kp and Ki Values on Flow Control: The following screens how some 
examples of what the flow graph looks like when Kp and Ki values are too high or too 
low. 

 
Figure 13-65 Valve Tuning, Kp Value Too High, or Ki Too Low 
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Figure 13-66 Valve Tuning, Kp and Ki Values Too Low 

Start with the original PID settings. Note that these may vary per device. 

 
Figure 13-67 Original PID Settings 

Increase the Kp value, the slope of the red circled part will slightly increase. 
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Figure 13-68 Valve Tuning, Increase Kp Value 

Increase the Ki value, to move the flow curve towards the set point curve. This 
change will be the most visible but might lead to overshoot and undershoot. 

 
Figure 13-69 Valve Tuning, Overshoot 

*NOTE: If you need a higher data sample rate (resolution), change the graph options 
to show fewer parameters (see Section 7.1). Uncheck the Auto Show Default 
Parameters check box and select only the parameters you need to view. Unchecking 
the Valve Position parameter can yield significant increases in sample rate 

 

13.19 Response Tuning (Pressure) 
Pressure response tuning optimizes the dynamic performance of the pressure 
controller device to changes in set point. You can use this feature to eliminate 
undesired undershoot and overshoot. 
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Note: PID values for pressure controllers are tuned in the factory. However these PID 
values might not be optimal for the customer’s setup. If you do need to adjust the 
response tuning, it is strongly recommended that you only adjust the PID Kp and Ki 
(proportional and integral gain) and anti-windup low/high limits. Only in rare occasions 
the Kd1 and Kd2 (derivative gain) values might improve performance. Anti-windup 
gain can be disabled by setting the anti-windup gain to 0. Do not use any other value 
than the default of 0.2 or 0. Tuning the anti-windup limits will help in solving 
undershoot and/or overshoot without slowing down the signal too much. 
Make sure that you have saved the device configuration prior to adjusting these 
values. For Brooks Expert Support Tool training, which includes training for response 
tuning, contact your local Brooks service representative. 
To tune the device’s response, you will set up a square wave for the set point. You will 
then make adjustments to tuning parameters to make the actual pressure graph match 
the set point’s square wave. 
Make sure that the valve pedestal value is correct, use the procedure in the “Pedestal 
Tuning” section above to get the correct value. 
To tune the device’s response: 

1. Open the Tune menu and click the Pressure Response Tuning button to display 
the Pressure Response Tuning window. 

Figure 13-70 shows some tuning values. 
 

 
Figure 13-70 Pressure Valve Tuning, Default Values 

2. Position the Graph window so that you can see the Tuning and Graph windows 
at same time. 

3. Set up the setpoint square wave, as shown in Figure 13-71 below. You should 
pick high and low set points that are at the expected range of your process 
application 
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Figure 13-71 Pressure Valve Tuning, Cycle Settings 

*NOTE: The Brooks Expert Support Tool is intended to be used for thermal mass flow 
controllers and thermal mass flow meters. If you are adjusting a meter model, use a 
separate flow controller to regulate the set point cycling. 

4. Click the Start button to begin flow. 
5. Observe how closely the actual flow matches the set point square wave. 
6. Start making adjustments using the PID Kp and Ki (proportional and integral 

gain) values. 
 

 

Effect of Kp and Ki Values on Pressure Control: The following screens show some 
examples of what the pressure graph looks like when Kp and Ki values are too high 
or too low. 

 
Figure 13-72 Pressure Valve Tuning, Kp Low 

A Kp value that is too low leads to oscillations in both the pressure reading and valve 
drive. 
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Figure 13-73 Pressure Valve Tuning, Ki Low 

A Ki value that is too low leads to a pressure reading curve that does not reach its 
end value in a straight line; see red circled part. 

 
Figure 13-74 Pressure Valve Tuning, Correct Kp and Ki Values 

Effect of Anti-Windup Settings on Pressure Control: Tuning the anti-windup low 
and high limits will remove any under- or overshoot of pressure response to a set 
point. The values of these limits are different for a normally closed versus a normally 
opened valve. By definition, the high limit should be higher in value than the low limit 
in all cases. 
Normally Closed Valve: For a normally closed valve, the default value of the low limit 
is 5% below the pedestal value. The high limit is the valve drive at the maximum 
pressure and maximum flow, plus a tolerance of 10%. 
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Figure 13-75 Anti-windup for a Normally Closed Valve 

Normally Open Valve: For a normally open valve, the default value of the high limit is 
5% above the pedestal value. The low limit is the inverse (100%-valve drive in 
percent) of the valve drive at the maximum pressure and maximum flow, minus a 
tolerance of 10%. 

 
Figure 13-76 Anti-windup for a Normally Open Valve 

*NOTE: If you need a higher data sample rate (resolution), change the graph options 
to show fewer parameters (see Section 7.1). Uncheck the Auto Show Default 
Parameters check box and select only the parameters you need to view. Unchecking 
the Valve Position parameter can yield significant increases in sample rate 

 
 
 
13.20 Print Top Label 

BEST software can be used to print a simple label used for the top of the device. Note 
that this is the small label, not to be confused with the label for the side of the device 
for GF40 devices after calibration.  
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The label by default displays the device serial number, gas, range and range units of 
the current page of the device. However, the user may optionally substitute any text. 
 
Some typical labels are: 
1. Brady PN: THT-59-423-10 3” core 1x0.5 (1 label wide) 
2. Brady PN: THT-59-533-2.5-SC 1” core 1x0.5  (3 labels wide) 
 
A license is not required. 
This feature is supported by all device types (including flow controllers and pressure 
controllers). A device does not need to be attached to print a top label. 
If a device is attached when this window is opened, the windows is populated with the 
device serial number, gas, range, and flow units of the current page of the device. 
However, the user may optionally substitute any text. 

 
Figure 13-77 Top Label 
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Figure 13-78 Print Top Label Window 

 
For device label printing, a label printer is required. All printer models are supported – 
the user is responsible for installing the printer manufacturer’s drivers as needed, as 
well as setting up the printer settings such as form feed, margins, etc. 

 



 

 

LIMITED WARRANTY 
Visit www.BrooksInstrument.com for the terms and conditions of our limited warranty. 
 
BROOKS SERVICE AND SUPPORT 
Brooks is committed to assuring all of our customers receive the ideal flow solution for their application, along with outstanding service and 
support to back it up. We operate first class repair facilities located around the world to provide     rapid response and support. Each location 
utilizes primary standard calibration equipment to ensure accuracy and reliability for repairs and recalibration and is certified by our local 
Weights and Measures Authorities and traceable to the relevant International Standards. 
Visit www.BrooksInstrument.com to locate the service location nearest to you. 
 
START-UP SERVICE AND IN-SITU CALIBRATION 
Brooks Instrument can provide start-up service prior to operation when required. 
For some process applications, where ISO-9001 Quality Certification is important, it is mandatory to verify and/or (re)calibrate the products 
periodically. In many cases this service can be provided under in-situ conditions, and the results will be traceable to the relevant international 
quality standards. 
 
CUSTOMER SEMINARS AND TRAINING 
Brooks Instrument can provide customer seminars and dedicated training to engineers, end users and maintenance persons. 
 
Please contact your nearest sales representative for more details. 
 
Due to Brooks Instrument's commitment to continuous improvement of our products, all specifications are subject to change without notice. 
 
TRADEMARKS 
Brooks is a trademark of Brooks Instrument, LLC 
All other trademarks are the property of their respective owners. 
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